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Welcome to Microsoft Access

W elcome to Microsoft® Access, an interactive relational database management 
system for Microsoft Windows™. Microsoft A ccess puts the power to organize, 
find, and present information in your hands.

Microsoft Access is graphical Microsoft Access takes full advantage of the 
graphical power in Windows, giving you visual access to data and simple, direct 
ways to view and work with your information.

Microsoft Access is for data navigation Its powerful querying and connective 
capabilities help you find the information you want quickly, regardless of format or 
location. You can use one query to work with data stored in different database 
formats and network locations. You can change your query at any time and see 
different layouts of data with the click of a button.
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Microsoft Access is for data publishing WYSIWYG (what you see is what you 
get) design tools help you produce sophisticated, effective forms and reports to meet 
your exact specifications. You can plot data, combine different forms and reports in 
one document, and present your results with publication-quality style.

Microsoft Access is a serious productivity tool Using Microsoft Access Wizards 
and macros, you can automate most tasks easily without the need for programming. 
For highly specialized data management needs, Microsoft Access comes with 
Access Basic, a powerful database programming language.

Where Do I Start?
This book is the best place to start. It’s your basic flight instruction for learning to 
pilot Microsoft Access. By the time you finish M icrosoft Access Getting Started , 
you’ll be ready to solo— to work on your own and explore the advanced techniques 
that will make you even more productive.

This book doesn’t just tell you about Microsoft Access; it helps you do productive 
work while you learn. It guides you through a series o f brief, hands-on sessions that 
use real-life examples to show you how to organize and work with data. You're not 
just going along for the ride— you're going to enjoy the flying.

You decide how to use this book. You can consult it for the steps you need to build 
and use your own Microsoft Access database, using your own data. For a more 
structured learning experience, you can follow the step-by-step scenarios, using the 
Northwind Traders sample database provided with Microsoft Access.

This book has four self-contained parts:

■ Part 1: Introducing Microsoft Access Leam the basic concepts, terms, and 
techniques you need to work with Microsoft Access. Use easy-to-follow  
instructions to set up and run Microsoft Access.

■ Part 2: Building a Database Build and use the basic elements of a Microsoft 
Access database: tables and forms.

■ Part 3: Working with Data Create a query, find and sort data, and combine 
data from two tables into a form.

■ Part 4: Presenting Your Data Create a report and mailing labels. Also leam  
how to use a Microsoft Access Wizard to add a button to a form.
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Before you begin using this book, you need to know the fundamentals of using 
Microsoft Windows. This book and all Microsoft Access documentation is written 
with the assumption that you know how to use a mouse, open a menu, and select 
options from a menu or a dialog box. If you need to review these techniques, consult 
the documentation that comes with Microsoft Windows.

N o te  The examples in this book and in all the Microsoft Access manuals are based 
on the fictional Northwind Traders import/export company. Northwind Traders 
specializes in gourmet foods from around the world. For details about the contents 
of the Northwind Traders database, see the “Introduction” in the M icrosoft Access 
User's Guide.
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Introducing Microsoft 
Access

Here’s where you begin your exploration of Microsoft Access. Part 1 
introduces you to what Microsoft Access is all about, shows you how to set 
up Microsoft Access on your computer, and provides a quick introduction to 
working in Microsoft Access.

■ Chapter 1, “Concepts and Terms,” introduces the basic concepts and 
terms you’ll need while you work with Microsoft Access.

■ Chapter 2, “Microsoft Access Basics,” explains how to set up Microsoft 
Access and open a database. It introduces the basic techniques for 
creating and using Microsoft Access objects.

“I’ve never used a database program, but I’ve used a spreadsheet and a word 
processor. What can I do with Microsoft Access that I couldn’t do before?”

“How do I set up Microsoft Access on my computer? Once it’s set up, how 
do I leam how to use it?”

“Now that I’ve switched to Microsoft Access from my old database program, 
I just want the big picture —  a quick tour of how Microsoft Access gets 
things done. Then I can jump in, play around, and figure out how it works 
myself.”



Concepts and Terms

This chapter introduces the basic concepts and terms you’ll find useful while you 
work with Microsoft Access.

Chapter Contents
What Is a Microsoft Access Database?
Tables, Queries, and Dynasets 
Forms and Reports 
Macros and Modules 
What’s Next?

The Challenge Before you take off, have a look around. Get to know the main 
parts of the Microsoft Access database that you’ll be working with.

The Approach A quick review of concepts and terms will help you get oriented 
and keep you from getting slowed down later.



8 Part 1 Introducing Microsoft Access

What Is a Microsoft Access Database?
A database is a collection of data that’s related to a particular topic or purpose. 
Employee records in a file cabinet, a stamp collection in an album, a collection of 
sales leads in a notebook —  each o f these collections of data is a database.

A database management system (DBMS) is a system that stores and retrieves 
information in a database: It’s the file cabinet, the album, or the notebook. A 
computerized DBMS is a program you can use to store and retrieve data on your 
computer. Microsoft Access is a relational database management system  
(RDBMS), which stores and retrieves information according to relationships you 
define. Using Microsoft Access, you can organize your data according to subject so 
that the data is easy to track and verify, and you can store information about how 
different subjects are related so that it’s easy to bring related data together.

To see the power behind this approach, consider a relational database that's not 
stored in a computer— one in which the relationships among the data are stored in 
your head. For example, you might keep information about products and suppliers 
in several places in your office. You might have a mailing list in a word processor 
file, a list of invoices in a spreadsheet file, information about products in a file 
cabinet, and supplier phone numbers in a card file next to the telephone.

Together, these containers of data form a relational database. Each container serves 
a particular purpose, and you can combine information from two or more of them to 
meet your special needs. The key element that makes the system work is your  
knowledge of how the information in the containers is related.
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Suppose that you decide to use a computer to manage your data. With a 
nonrelational DBMS program, you might create one large table in your database 
that holds all of your information— telephone numbers, product information, 
invoices, everything.

With this database, you’d end up storing a lot of duplicate data. Each time you add 
a new product, for example, you might want to include the supplier’s phone number 
so that you can easily find it when you need it. If you bought 10 products from the 
same supplier, you’d store the supplier’s phone number 10 times. Your table would 
get very large and require a lot of extra disk space. If any information changed, 
you’d have to change it everywhere it appeared— maybe hundreds of places. That 
would take a great deal of time, and you could easily make an error in the process. 
Finally, when you want to change the structure of your data— add fax numbers, for 
example, or group products into categories— you would be in for a lot of tedious, 
error-prone work to revise the structure of your database table.

In contrast, a Microsoft Access database can have several small tables, much like 
the containers in your office. You can design your database so that it also stores 
information about how the tables are related.

Customers

= =
Relationship

Suppliers

-  -  •

Relationship
M----------------►

Invoices

Relationship
Product Information

a iw w r

•iWW »:

Microsoft Access relational database

Each piece o f information is stored in only one place. That saves storage space by 
eliminating duplication. It makes updating information faster and more accurate, 
because you make a change in only one place. You can restructure a small table in a 
relational database much more easily than you can a large table in a nonrelational 
database. Also, you can add tables for new topics of information without changing 
the existing tables.

The rest of this chapter introduces you to the main parts of a Microsoft Access 
database and shows you how they fit together.

Key Terms
d a ta b a s e  A collection o f data that’s related to a particular topic or purpose.

RDBMS Relational database management system; software, such as Microsoft 
Access, that enables you to organize and analyze data stored in tables in a database.
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Tables, Queries, and Dynasets
You use data in a wide variety of formats — for example, in mailing labels, lists, 
forms, reports, and graphs. You can use Microsoft Access to create the labels, lists, 
forms, reports, and graphs you need to present your data just the way you want, but 
you store the data itself in tables.

A  Table— Data with a Subject
A table is a collection of data about a particular subject. The data in a table is pre­
sented in columns (called fields) and rows (called records). All data in a table 
describes the subject of the table. For example, one table might store data about the 
products you sell, another about customers, and a third about suppliers.

— Rows (records)

Suppliers Table
Company Name Contact Name Contact Title
Exotic Liquids Charlotte Cooper Purchasing Manager
New Orleans Cajun Delights Shelley Burke Order Administrator
Grandma Kelly’s Homestead Regina Murphy Sales Representative
Tokyo Traders Yoshi Nagase Marketing Manager
Mayumi’s Mayumi Ohno Marketing Representative
Pavlova, Ltd. Ian Devling Marketing Manager
Specialty Biscuits, Ltd.

\

Peter Wilson Sales Representative

/

Columns (fields)

In a table, a fie ld  is a category of information. It could be company names, 
employee hire dates, or product prices. A record  is a collection of information 
about one person, thing, or event. It could be all the information about a product, a 
transaction, or a supplier.

Each record in a table contains the same set of fields, and each field contains the 
same type of information for each record. You use values in fields to pinpoint the 
records you want to see. For example, suppose that you want to print mailing labels 
for suppliers located in Paris. You can tell Microsoft Access to retrieve only the 
records that have the value “Paris” in the City field. Microsoft Access prints the 
labels you want and no others.

M o re  In fo rm a tio n  For tips on designing the tables in your database and deciding 
what fields belong in each table, see Chapter 2, “Designing a Database,” in the 
M icrosoft Access User's Guide.
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A  Query and Its Dynaset—A  Question and an Answ er
A query is a question you ask about the data in your database, such as, “Which 
products have Australian suppliers?” The data that answers the question can be 
from a single table or several — the query brings the information together. The set 
of records that a query describes is called a dynaset. A dynaset is an updatable type 
of recordset, which is any set of records defined by a table or query.

Australian Suppliers Query
Product Nam e Company Nam e City Country
Pavlova Pavlova, Ltd. Melbourne Australia
Alice Mutton Pavlova, Ltd. Melbourne Australia
Carnarvon Tigers Pavlova, Ltd. Melbourne Australia
Vegie-spread Pavlova, Ltd. Melbourne Australia
Outback Lager Pavlova, Ltd. Melbourne Australia
Manjimup Dried Apples G ’day, Mate Sydney Australia
Filo Mix G ’day, Mate Sydney Australia
Perth Pasties G ’day, Mate Sydney Australia

Data from the Data from the
Products table Suppliers table

You create a query that describes the set of records you want. When you use the 
query to access data, you automatically get current data from the tables. If you 
change the data in a dynaset, Microsoft Access updates the data in the underlying 
tables. In a multiuser environment, you can see changes that others make to records 
in a dynaset right away.

Because the data in a dynaset is always current, you can use queries and their 
dynasets with the confidence that the data you’re viewing is up to date and that the 
changes you make are saved. In terms of accessing data, you’ll find that there’s not 
much difference in the way you use tables and the way you use dynasets. The main 
difference between them is that data is stored in tables but not in dynasets.

Key Terms
d y n a s e t A dynamic, updatable type of recordset, which is any set of records 
defined by a table or query.

q u e ry  A Microsoft Access object that asks a question or defines a set of criteria 
about data from your tables.

tab le  A Microsoft Access object that stores data in rows (records) and columns



12 P a r ti  Introducing Microsoft Access

(fields). The data is usually about a particular subject, such as employees or sales.

Forms and Reports
A tabular arrangement of data is convenient for viewing many records at the same 
time. To focus on individual records or to present your data using a custom layout, 
you can use a form or a report. As you’ll see later in this book, with the help of 
Access Wizards you’re only a few mouse clicks away from a variety of stylish 
presentations of your data.

A  Fo rm — Information on the Screen or in Print
A form  is often the most convenient layout for entering, changing, and viewing 
records in your database. You specify how data is displayed when you design your 
form. When you open a form, Microsoft Access retrieves the data you want from 
your tables and displays it according to your design, on the screen or in print.

EC

ifin k s , c o ffe e s , te a s , b e e r , a n d  alej 

ii

Categories Table
Category ID Category Name Description Picture

Beverages 
Condiments 
Confections 
Dairy Products 
Grains/Cereals

Soft drinks, coffees, teas, beer, and ale Paintbrush Picture 
Sweet and savory sauces, relishes, spreads, Paintbrush Picture 
Desserts, candies, sweet breads Paintbrush Picture
Cheeses Paintbrush Picture
Breads, crackers, pasta, and cereal Paintbrush Picture

With a Microsoft Access form, you can include lists of values to choose from, use 
colors to highlight important data, and display messages to indicate when an 
incorrect value is entered. Also, you can have Microsoft Access automatically fill in 
data for you and display the results of calculations. With one click, you can switch 
from Form view to Datasheet view, which is a tabular view o f the same set of 
records.
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A  Report— Polished Results in Print
You use a report to present your data on the printed page and to show totals and 
grand totals across an entire set of records. With the power and control a report 
provides, you can get presentation-quality reports with minimum effort.

Sales by Date
26-Sep-93

Shipped Date: Order ID: Company: Order Subtotal:

03-Jan-94 10864 Around the Hom $282.00
10869 Seven Seas Imports $1.630.00
10872 Godos Cocina Típica $2.058.00
10873 Wilman Kala S337.00

Total for 03-Jan-94 $4.307.00

04-Jan-94 10847 Save-a-loi Markets $4.932.00
10856 Antonio Moreno Taquería $660.00
10871 Bon app' $1.979.00

Total for 04-Jan-94 $7.571.00

05-Jan-94 10867 Lonesome Pine Restaurant $98.00
10874 Godos Cocina Típica $310.00

Total for 05-Jan-94 $408.00

06-Jan-94 10865 QUICK-Stop $16.388.00
10866 Berglunds snabbkop $1.096.00
10876 Bon app' S917.00
10878 QUICK-Stop $1.539.00
10879 Wilman Kala $611.00

Total for 06-Jan-94 $20,551.00

Grand Total: S32.837.00

The items on a form or report that display or print data are called controls. With a 
control, you can display data from a field; the results of a calculation; words for a 
title or message: or a graph, picture, or other object— even another form or report.

Key Terms
c o n tro l An item on a form or report that displays data from a field; the results o f a 
calculation; words for a title or message; or a graph, picture, or other object.

fo rm  An object you can use to enter, change, and view records of data in a custom 
layout. You can use a form to display records on the screen or in print.

re po rt An object you can use to print records in a custom layout. You can use a 
report to group records and show totals for groups or for an entire report.
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Macros and Modules
Microsoft Access provides a variety o f objects that you can use to display and 
manage information. Your Microsoft Access database can be an even more 
powerful productivity tool when these objects work together. You can use macros 
and modules to combine objects in your database into a data management system  
that works for you.

A  Macro—Autom ation Without Programming
To automate basic actions and get objects to work together without programming, 
you can use macros. A macro is a list of actions you want Microsoft Access to 
carry out for you. For example, you might want Microsoft Access to automatically 
open a set o f forms when you open your database. Or, you might want to click a 
button to print monthly reports or to open another form.

In the Sales Reps 
form, a macro is 
attached to this button, 
When you press 
the button...

...the macro opens the 
Sales Totals form.

You can use macros in a wide variety of places. For example, you can attach a 
macro to a form, report, control, keystroke combination, or menu command.

A  Module—The Power of Programming
For the greatest possible control over your database operations, Microsoft Access 
provides a powerful, built-in database programming language, Access Basic. You 
can use procedures written in Access Basic for operations that require more 
complex, automated processing than what macros can provide. A module is a 
Microsoft Access object that contains your Access Basic procedures.



Chapter 1 Concepts and Term s 15

For example, suppose that you intend to use the same long, complicated calculation 
in several queries or reports. Rather than type the expression everywhere you need 
it, you can write a function in Access Basic that performs the calculation and then 
run the function whenever you want to use the expression. You can also use Access 
Basic to repeat a certain operation until a condition you set is true.

This book explains how to create every Microsoft Access object introduced in this 
chapter except for macros and modules. For information about creating macros, see 
Chapter 24, “Macro Basics,” in the Microsoft Access User's Guide. For 
information about creating modules, see Microsoft Access Building Applications.

Tip You can use an Access Wizard to automate forms without writing macros or 
modules. An Access Wizard is like a database expert who prompts you with 
questions about the object you want and then builds it based on your answers. To 
automate a form, you can use the Command Button Wizard, which creates a kind of  
control called a command button and prompts you to choose an action for the 
button to perform (such as opening another form). You’ll see how the Command 
Button Wizard works in Chapter 10, “Customizing and Automating.” Other Access 
Wizards are mentioned throughout this book.

A n  Object— Something Yo u  Can Select
This chapter introduced you to some of the objects that you can create and use in 
Microsoft Access: tables, queries, forms, reports, controls, macros, and modules. In 
Microsoft Access, you’ll see the word “object” used for other items as well, 
including pictures, graphs, dialog boxes, documents created by other applications, 
or even the Clipboard. In general, an object is something that you can select and 
manipulate as a unit.

Key Terms
Access Basic The Microsoft Access built-in database programming language.

macro A list of actions you want Microsoft Access to carry out for you. When you 
run a macro, Microsoft Access carries out the actions in the macro.

module A collection o f one or more Access Basic procedures.

Object An item such as a table, form, or control that you can select and manipulate 
as a unit.
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What’s Next?
Now that you know the basic concepts and terms, you’re ready to start working 
with Microsoft Access. In Chapter 2, you’ll set up Microsoft Access, learn how to 
create a new database, and find out how to create and use Microsoft Access objects.
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Microsoft Access Basics

17

In this chapter, you’ll set up and start Microsoft Access. Then, in a quick tour of 
Microsoft Access, you’ll find out how to open a database and gain access to data. 
You’ll also learn how to create a database and database objects. Finally, you’ll get 
an introduction to Microsoft Access documentation and learn how to find the 
information you need to carry out your tasks.

Chapter Contents
Setting Up, Starting, and Quitting Microsoft Access
Opening a Database
The Database Window
Viewing Data and Closing a Database
Creating a Microsoft Access Database
Creating Objects
Using Microsoft Access Documentation 
What’s Next?

The Challenge Now that you know the main features of a Microsoft Access 
database, it's time to jump into the cockpit and start the engine.

The Approach Y ou’re ready to set up Microsoft Access, start it, and begin to use 
Microsoft Access objects.
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Setting Up, Starting, and Quitting Microsoft Access
Before you set up Microsoft Access, take a few minutes to make sure your 
computer meets the minimum requirements needed to run Microsoft Access.

Microsoft Access Requirements
To use Microsoft Access, you need the following:

■ An IBM-compatible personal computer with an 80386sx, 80386, or higher 
processor (386/20 is recommended).

■ A hard disk with 21.5 megabytes of free space (typical installation).

■ A Microsoft Mouse® or other compatible pointing device.

■ An EGA, VGA, or compatible display (VGA or higher is recommended).

■ Six megabytes of random-access memory (8 megabytes are recommended).

■ MS-DOS® operating system version 3.1 or later.

■ Microsoft Windows™, Windows for Workgroups™, or Windows NT™ 
operating system version 3.1 or later.

Setting Up Microsoft Access
Use the Setup program (SETUP.EXE) to set up Microsoft Access on your 
computer.

N o te  If you’re upgrading from an earlier version of Microsoft Access, you may 
want to keep the earlier version on your computer until you’ve converted your 
database to version 2.0 format. For more information on upgrading to version 2.0, 
and for complete details about installing Microsoft Access, see Chapter 1,
“Setting Up Microsoft Access,” in the Microsoft Access User's Guide.
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► To set up Microsoft Access

1. Insert Disk 1 in drive A.

2. Start Windows.

3. In the Windows Program Manager, choose Run from the File menu.

Windows displays the Run dialog box.

4. Type a:setup in the Command Line box.

5. Choose OK.

6. Follow the setup instructions on the screen.

When you set up Microsoft Access, you can conserve hard disk space by choosing 
the Complete/Custom installation option and selecting only the components you 
want to install. If you do this, be sure to select the Northwind Traders sample 
database so that you can follow the examples in this book.

If you’re setting up Microsoft Access on a network, the Setup program will prompt 
you with questions about the kind of network you have. If you’ll be using Microsoft 
Access to use data that’s stored in SQL databases on your network, you must 
choose the Complete/Custom installation option and install ODBC Support.

After installing the files you need, the Setup program places the Microsoft Access 
icon in the Microsoft Office program group (or the program group you specified).

Microsoft Access icon
Microsoft

A ccess
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Starting and Quitting Microsoft Access
You start and quit Microsoft Access in the same way as you do other Windows- 
based applications.

► To start Microsoft Access

1. In the Windows Program Manager, open the program group that contains the 
Microsoft Access icon.

2. Double-click the Microsoft Access icon.

Microsoft Access starts and displays the Microsoft Access startup window. 
From here, you can create or open a database, or you can do basic database 
administration tasks.

You can customize how Microsoft Access starts by using options in the command 
line for Microsoft Access. For example, you can have Microsoft Access 
automatically open a database or run a macro that you specify.
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► To add options to the Microsoft Access command line

1. In the Windows Program Manager, click the Microsoft Access icon.

2. From the File menu, choose Properties.

Windows displays the Program Item Properties dialog box.

3. Add the options you want to the command line.

For example, to have Microsoft Access automatically open the Northwind 
Traders database file, NWIND.MDB, enter the following command line in the 
Command Line box:

C:\ACCESS\SAMPAPPS\NWIND.MDB

If you installed the Microsoft Access sample databases in a different directory, 
substitute that directory for SAMPAPPS in the command line.

4. Choose OK.

M o re  In fo rm a tion  For details about other startup options, choose Search from the 
Microsoft Access Help menu and search for “starting Microsoft Access.”

► To quit Microsoft Access

•  From the File menu, choose Exit.
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Opening a Database
A Microsoft Access database is a collection o f objects, not just a single table of 
data. One database file contains the tables as well as queries, forms, reports, and 
other objects that help you use the information in the database.

Tables

E l
m
s
m
0
m
m
m

Categories
Customers
Employees

Queries

ÉP
gP
flp
ÉP
IP
# )
oP
eP
IP

Catalog 
Customer List 
Daily Order Totals

Forms

Add Products 
Categories 
Categories Subform

Reports

Alphabetical List of Products 
Catalog
Customer Mailing Labels 
Employee Sales by Country 
Invoice
List of Products by Category 
Percentages of Sales 
Sales by Category

— All these objects are 
contained in one database 
file, NWIND.MDB.

To see how to work with objects in a database, follow the steps given here to open 
the Northwind sample database provided with Microsoft Access. (You can have 
only one Microsoft Access database open at a time; however, you can have many 
tables open in a database at the same time.)

► To open a database

1. If necessary, start Microsoft Access.

\ ç ÿ \  2. From the File menu, choose Open Database (or click the Open Database button
on the toolbar).

Microsoft Access displays the Open Database dialog box.

3. In the File Name list box, select NWIND.MDB.
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When you set up Microsoft Access, the Setup program copied NWIND.MDB  
into the directory that contains your Microsoft Access sample applications. If 
necessary, use the Directories list box to change to that directory. For help about 
the Open Database dialog box, press the f i  key.

r  Northwind database

\

Open Database
File Name:

\
nwind.mdb

orders.mdb
solution.mdb

List Filet of lype:

Directories: 
c: \access\sampapps

£3 c:\
&  access 
f t  sampapps

Drives:

I Databases (z.mdb) [̂ ] |"1

OK

Cancel I

r  Read Only 

[x Exclusive

4. Choose OK.

Microsoft Access displays the NWIND Database window.

N o te  In version 2.0 of Microsoft Access, you can open and use database files 
created in version 1.0 or 1.1 and you can save changes to the data in those files, but 
you cannot save changes to objects such as queries, forms, and reports. To do this, 
you must convert the database to version 2.0. After you convert the database, you 
can use it only with version 2.0. For more information, see Chapter 1, “Setting Up 
Microsoft Access,” in the Microsoft Access User's Guide.

The Database window displays a list of the tables in the database. The Northwind 
database contains tables that store information about the operations o f the 
Northwind Traders import/export company.

Next, you’ll see how you can use the Database window for quick access to any 
object in your database.

N o te  You can use the same keyboard and mouse techniques to navigate through 
Microsoft Access dialog boxes that you use for any other application for Windows. 
For more information on using dialog boxes, see your Windows documentation.
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The Database Window
When you create or open a database, Microsoft Access displays its Database 
window in the Microsoft Access window. The Database window is your command 
center. From here, you can create and use any object in your database.

Menu bar
i

Toolbar
1

File Edit View Security Window Help

inwaBPwei EHEI

HI
Table

éP
Query

m
Fora

El
Report

n
Macro

4
Module

Tables
■ EPPS
HID C u s to m e rs
f ^ l  E m p lo y e e s
dUl O rd e r  De ta ils
HID O rd e rs
iHH P r o d u c ts
HID S h ip p e rs
[HH S u p plie rs

Ready HUM

Database window - 1 Microsoft Access window - 1

The menu bar includes menus and commands you can use to create and use objects 
in your database. The toolbar contains options you use to do common operations 
and get help on your current task.

As you create objects and open new windows in Microsoft Access, the menu bar 
and toolbar change to display commands and options that are applicable for 
working in each window. In the next section, you’ll see how you can use buttons on 
the toolbar to see different views of your data.
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Object buttons

Click here...

The object buttons in the Database window provide direct access to every object in 
your database.

New 11 Open | | Design |

mTable
oP

. Query

Report

n
Macro

Tables
ID !..... .......
[HH C u s to m e rs
mD E m p lo y e e s
EUD O rd e r  D e ta ils
H I  O rd e rs
EHi] P r o d u c ts
OH] S h ip p e rs
mD Su p plie rs

List of tables 
in the database

For example, to see a list of forms in the database, click the Form button.

m
Table

Query

Forms

m  \.................... :.. :...
H I  Categories
M  Categories Subform
M  Country Filter Dialog
I H  Customers^

...to see the list of forms.

Microsoft Access displays the list of forms stored in the database. To return to the 
list of tables, click the Table button. In the next section, you’ll see how you can 
open a table, form, or other object directly from the Database window.
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Viewing Data and Closing a Database
With Microsoft Access, viewing your data is only one or two mouse clicks away. 
With another click of the mouse button, you can switch to a different view of your 
data.

► To view data in a table

1. In the Database window, click the Table button to display the list o f tables in the 
database.

2. Double-click the name of the table you want to see. For example, in the 
Northwind database, double-click the Suppliers table.

Microsoft Access displays the table in Datasheet view.

» ?R U N «

SuDnlier ID I Cohidanv Name 1 Contact Name 1 Conl ♦

1 
1 

1 
1 

1 
1 

1 
K |1 E x o tic  Liq u id s

2 N e w  O rle a n s  C a ju n  D e lig h ts
3 G r a n d m a  Kelly's  H o m e s te a d
4 T  o k y o  T  raders
5 C o o p e ra tiv a  d e  Q u e s o s  ‘L a s  C a b r a s '
6 M a y u m i's
7  P a v l o v a , L t d .
8 S p e c ia lty  B is cu its , L t d .

C h a rlo tte  C o o p e r  
Sh e lle y  B u r k e  
R e g in a  M u r p h y  
Y o s h i  N a g a s e  
A n t o n io  d el V a lle  S a a v e d r a  
M a y u m i O h n o  
Ia n  D e v lin g  
Pe te r  W ils o n

Pu r c h a s in g  
O rd e r  A d m ir  
S a le s  R e p re  
M a rk e tin g  № 
E x p o r t  A d m i 
M a rk e tin g  R 
M a rk e tin g  K* 
S a le s  R e p re T

M | « | R e c o r d : | 1  [ O f  2 9  | t | M |  M  | h

Datasheet view displays data from the table in columns and rows, similar to a 
spreadsheet. In a datasheet, you can resize and rearrange the columns (fields) 
and resize the rows (records). You can scroll vertically to see more records and 
horizontally to see more fields.

WTien you’re ready to return to the Database window, click the window (or click 
the Database Window button on the toolbar).

It’s just as easy to see a query’s dynaset as it is to see a table. Click the Query 
button in the Database window, and then double-click the query you want to view. 
Microsoft Access displays the dynaset in Datasheet view.

You use the same technique to view a form.
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► To view data using a form

1. In the Database window, click the Form button to display the list o f forms.

2. Double-click the name of the form you want to view. For example, in the 
Northwind database, double-click the Suppliers form.

Microsoft Access opens the form and displays the first record of data.

You can also display a form in Datasheet view. To switch from Form view to 
Datasheet view, click the Datasheet View button on the toolbar.

Microsoft Access displays the records in a datasheet.

j] C h a rlo tte  C o o p e r
2  S h e lle y  B u r k e
3 R e g in a  M u r p h y
4  Y o s h i  N a g a s e

P u r c h a s in g  M  a n a g e r E  xotic Liq u id s
0  rder A d m in istra to r N  e w  0  rleans C a ju n  D  elights
S a les  R e p r e s e n t a tiv e  G r a n d m a  Ke lly's  H o m e s te a d
M  a rk e tin g  M  a n a g e r T  o k y o  T  raders fl

When you finish looking at the Suppliers form, close the Northwind database.

To close a database

1. Switch to the Database window if it isn’t active. (Click the Database window, 
or click the Database Window button on the toolbar.)

2. From the File menu, choose Close Database.
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Creating a Microsoft Access Database

►

When you create a Microsoft Access database, you create one file that contains all 
the tables in your database as well as the queries, forms, reports, and other objects 
that help you use the information in the database.

N o te  These steps explain how to create a database. The remaining chapters in this 
manual use NWIND.MDB, the Northwind sample database provided with 
Microsoft Access, to explain how to create and use Microsoft Access database 
objects. If you’d rather experiment with the sample database before creating your 
own database, read “Using Microsoft Access Documentation” later in this chapter, 
and then see Chapter 3, “Creating a Table.” If you want to create your own 
database now, follow the steps given here.

To create a Microsoft Access database

1. In the Microsoft Access startup window, choose New Database from the File 
menu (or click the New Database button on the toolbar).

Microsoft Access displays the New Database dialog box. It gives your new 
database a default name, which you can replace with the name of your choice.

File Name: Directories: 
c: \access\sampapps I 0IC I

I c:\
(5  access 
f t  sampapps

Cancel |

|x Exclusive

List Files of Type: Drives:

I Databases (\mdb) [Tj | S  c: a
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2. In the File Name box, type the name o f your database.

A database name can contain up to eight characters but cannot contain spaces. 
Microsoft Access automatically appends an .MDB extension to your database 
filename if you do not add an extension.

3. To store the database in a different directory, select the directory you want in the 
Directories list.

If you need to change drives, select the drive you want in the Drives list.

4. Choose OK.

Microsoft Access creates an empty database file and opens the Database 
window.
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Creating Objects
Your first step in building a database is to create tables. Whatever kind of data you 
have, you need one or more tables in the database to store it. After you have your 
tables, you can create queries, forms, reports, and other objects that help you use 
your data. You can also change the way an object appears or works by changing its 
properties, and you can use Access Wizards and tools to create and change objects.

N o te  These are the basic steps for creating a table as well as for creating any other 
Microsoft Access object. If you want, you can experiment with Microsoft Access 
by trying these steps now. For details about creating each type of object, see the 
remaining chapters in this book.

Create or Modify an Object
You can create or modify an object of any type from the Database window.

► To create a Microsoft Access object
1. In the Database window, click the object button for the type of object you want 

to create.

For example, to create a new table, click the Table button.

2. Choose the New button. (Or, from the File menu, choose New, and then choose 
the type of object you want to create.)

— Click the button for the type of object you want to create... 

r—...and then choose the New button.

C M  Tables
Table

 ̂Report
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For some types of objects, such as forms and reports, Microsoft Access displays a 
dialog box where you can select tables on which to base the form or report. For 
tables, queries, forms, and reports, you can choose whether to use an Access 
Wizard to help you create the object.

► To modify the design of an object

1. In the Database window, click the button for the type of object you want to 
modify.

2. In the list that’s displayed, select the object you want to modify.

3. Choose the Design button.

Microsoft Access opens a window for the object and displays it in Design view.

The Role of Properties
A property’ is a characteristic of an object, such as its name, size, or color. All 
Microsoft Access objects have properties that you can set to determine how the 
object appears or works.

For example, one field property is called the Format property. This property tells 
Microsoft Access which format to use when displaying data from the field. If you 
set the Format property o f a field that contains dates to the Medium Date format, 
for example, Microsoft Access displays the dates in this format: 17-Apr-94. When 
you view data from the field in a datasheet or form, Microsoft Access automatically 
displays the data in the format set for that field. To show the dates in a different 
format, change the setting of the field’s Format property.

Later in this book, you’ll see how to set properties for tables, fields, forms, controls, 
and other Microsoft Access objects.
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Use Access Wizards to Create Objects
When you create a new table, query, form, or report, Microsoft Access displays a 
dialog box where you can choose whether to start with a blank object and build it 
yourself or use an Access Wizard to help you build it.

Select A Xable/Query:

□
FormWizards Blank Form 

Cancel |

An Access Wizard is like a database expert who prompts you with questions about 
the object you want and then builds the object based on your answers. You can see 
how this works in Chapter 3, “Creating a Table.” Other Access Wizards help you 
with other tasks and are described throughout this book.
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Arrange Tools to Suit Y o u r Working Style
Microsoft Access provides a wide variety of graphical tools you can use to create 
and modify objects in your database. Tools appear when you’re likely to use them. 
For example, when you first start Microsoft Access, the toolbar at the top of the 
Microsoft Access window displays tools for opening a database, creating a new 
database, and getting help. After you open a database, the toolbar gains tools for 
creating and working with database objects. When you open a form in Design view, 
the toolbar displays tools for adding and modifying controls and for switching 
between Design view, Form view, and Datasheet view.

Initially, the toolbar appears at the top of the Microsoft Access window, and tools 
are arranged in a single long row. However, you can pull the toolbar into the middle 
of the window, change its shape, and even change the tools it contains. For 
example, you might assemble the tools you use most often or remove tools you 
don’t use so that they don’t get in your way. Microsoft Access saves your 
arrangements and keeps tools where you put them.

Initially, the toolbar appears at the top of the screen.

- M *
File Edit View Security Window Help

1 1X K l  1 i l  s,i§g|ss| I tH a la llÔ H â le il H a k ? l

3 l
&1* £dlt You can dock the 
jg] toolbar vertically
&  at the side of the

screen...

[a

m
äö

H
m
31

...or pull it into 
the center.

M o re  In fo rm a tio n  For details about arranging and changing the toolbar, see 
Appendix B, “Working with Toolbars,” in the Microsoft Access User's Guide.
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Using Microsoft Access Documentation
Microsoft Access comes with a complete set of printed and online learning and 
reference tools.

Learning Microsoft Access
There are two ways to learn Microsoft Access:

■ Microsoft Access Getting Started This book uses real-life examples to show 
you how to create and use a Microsoft Access database. Use it as a source of  
ideas as well as a quick way to learn the basics of Microsoft Access.

■ Cue Cards Cue Cards provides step-by-step instructions to help you learn 
Microsoft Access as you build and use your own database. Cue Cards can walk 
you through your tasks from start to finish with graphical examples, guidance, 
and cross-references to online reference material.

si
Field Name

C a te g o r y  ID  
C a te g o r y  N a m e  
D e s c rip tio n  
P ic tu re

I Data T ype I
Table: Categories

T e x t 
T e x t  
M e m o  
O L E  O b je c t

U n iq u e  four-letter ab bri 
N a m e  of fo o d  c a te g o ry

A  picture re pre se n tin g

Field Properties

Menu Search | Back
¿£Ü9HLJ
ü D H i

Design a Table
Microsoft Access stores you data in 
tables. You can design the tables to store 
your data efficiently and accurately.

► What do you want to do?

CD See examples of tables.

Add fields.
I~>1 Set field properties.

I~>1 Set the primary key.

m  Save the table design.

To open Cue Cards

•  From the Help menu, choose Cue Cards (or click the Cue Cards button on the 
toolbar).

Microsoft Access Manuals
Microsoft Access comes with these manuals:

■ Microsoft Access Getting Started Use this book to set up and learn how to 
use Microsoft Access.

■ Microsoft Access User’s Guide This book provides in-depth information and 
examples for building and using your database.

■ Microsoft Access Building Applications This book describes how you can
create custom applications with Microsoft Access, and it provides an 
introduction to Access Basic, the Microsoft Access programming language.
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Check the status bar for hints as you use Microsoft Access.

When you point to an item in the 
Microsoft Access window, the status bar 
displays useful information.

m u
Design view. F6 = Switch panes. F1 =Help.

' ^  status bar

If you need more help, it’s just a keystroke away.

To get help

•  Press Fi (or click the Help button on the toolbar and then click the item about 
which you want help).

Help provides both “how-to” and reference information for all Microsoft Access 
tasks.

Microsoft Access manuals include cross-references to specific Help topics. When a 
manual tells you to “search Help,” use the Search command in Help to search for a 
given word or phrase.

To search for a Help topic

1. From the Help menu, choose Search (or choose the Search button in the Help 
window).

Microsoft Access displays the Search dialog box.

2. Type the first few letters of the subject you want to search for.

When you type, Help changes the keywords in the list box.

3. Double-click a keyword related to your subject (or select a keyword and press 
e n te r ) .

Help displays the relevant topics for that subject.

4. Double-click your topic (or select the topic you want and press e n te r ) .

M ore  In fo rm a tio n  For more information about using Help, press Fi from the Help 
window.
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What’ s Next?
Now that you know the basics, you’re ready to start working with Microsoft 
Access.

The rest of this book consists of three self-contained parts:

■ Part 2: Building a Database Build and use the basic elements of a Microsoft 
Access database: tables and forms.

■ Part 3: Working with Data Create a query, find and sort data, and combine 
data from two tables into one form.

■ Part 4: Presenting Your Data Create a report and mailing labels. Learn how 
to use a Wizard to add a command button to a form.

You can start with any of the three parts, depending on what you want to do first. 
You’ll probably want to start by building a database, in which case Part 2 is the 
best choice. If you’re using a Microsoft Access database that is already built, start 
with either Part 3 or Part 4.
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Building a Database

In Part 2 of M icrosoft Access Getting Started , you’ll learn how to build the 
basic elements o f a Microsoft Access database: tables and forms.

■ Chapter 3, “Creating a Table,” shows you how to use the Table Wizard to 
create a Microsoft Access table and how to start entering data in the table. 
In addition, you’ll import data from a dBASE IV file.

■ Chapter 4, “Creating a Form,” explains how to use a Forifc Wizard to 
create a form for viewing and modifying data.

■ Chapter 5, “Customizing Your Form,” explains how to improve your 
form’s appearance, add controls, and customize your form so that it works 
for you.

“I keep employee information in file folders. My customer information is in a 
card file on my desk. How do I get it all into a Microsoft Access database?”

“I have plenty of data in my computer already. Some of it’s in spreadsheet 
files and some of it’s in dBASE files. Can I use Microsoft Access to put it all 
together?”

“Sometimes I want to see my data in columns and rows, like in a spreadsheet. 
Other times I want a layout like the paper form we use. Oh, and when I enter 
data, I want to be sure my data’s correct. Is that hard to do?”
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Creating a Table

In this chapter, you’ll learn how to use the Table Wizard to create a Microsoft 
Access table, define its fields, and add data to it. In addition, you’ll learn how to 
import data that’s stored in a different file format.

Chapter Contents
Design a Table from a Paper Form
Create a Table with the Table Wizard
Plan Fields and Data Types
Add Fields to the Table
Set Field Properties
Add and Save Records
Edit Records and Close a Table
Delete, Insert, and Rearrange Fields in a Table
Resize Columns and Rows and Move Columns in a Datasheet
Print, Minimize, Restore, and Close a Table
Import Data
What’s Next?

The Challenge Each year, Northwind Traders attends trade shows around the 
world. Sometimes the company participates as a vendor; other times it sends an 
employee to meet with suppliers, investigate new products, and see what 
competitors are doing. You need to track information about trade shows and 
coordinate the employee representative for the show.

The Approach You need a table in the Northwind Traders company database to 
keep track of the trade shows. You’ll use the Table Wizard to create a table, add a 
few fields to the table, and then add records for the first two trade shows.
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Design a Table from a Paper Form
All data in Microsoft Access databases is stored in tables. The table you create in 
this example keeps track of trade shows that Northwind Traders attends. Each 
record in the Trade Shows table contains information about one trade show.

Until now, Northwind Traders used a paper tracking sheet to record information 
about trade shows. The fields in the new Trade Shows table will correspond to the 
blanks on the existing tracking sheet.

Northwind Traders
Trade Show Tracking Fonn

W orld F oods 1 7
Event Name Event ID Employee ID

7 - J u ly - 9 4 Status
Start Date 1 - Inquired
1 4 - J u l y - 9 4 2 - Applied
End Date (3)- Confirmed

L ondon 4 - Attended
Location □  Vendor

$ 3 , 7 2 5 . 0 0 Questions? Call
Fee Laura Callahan at x2344

n  The record for one trade show

Trade Shows Table
Event ID Event Name Status
1 World Foods 3
2 Gourmet Expo 1
3 International Food Fair 2

Each row in the 
table is a record. J
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In My Case: What Tables Belong in My Database?
By looking at the tables in the Northwind database, you can probably guess 
the purpose that the database serves. The Customers, Employees, Orders, 
and Order Details tables are used to record sales. The Products, Categories, 
and Suppliers tables are used to record inventory. Each of these tables 
represents a particular subject in the Northwind database. Together, the 
tables contain related information about the Northwind Traders 
import/export company.

Your first step in designing a database is to talk to the people who’ll use the 
database. Determine what information they’ll need to get from the database, 
and then group this information into subjects for your tables. Sketch out 
possibilities for your tables on paper. Each table in your database should 
store facts about a single subject— about customers, for example, or 
products. Once you decide on your tables, you can create them in Microsoft 
Access, add a few records of data to them, and test the database to see if 
your tables provide the information you want.

M o re  In fo rm a tio n  For a more complete discussion of the database design 
process, see Chapter 2, “Designing a Database,” in the M icrosoft Access 
User's Guide.
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Create a Table with the Table Wizard
You’ll create the Trade Shows table and define five of its fields by using the Table 
Wizard. Later, you’ll add four more fields in Design view to complete the table.

► To create a table using the Table Wizard

1. Start Microsoft Access, and open the NWIND.MDB database.

For detailed steps on starting Microsoft Access and opening a database, see 
Chapter 2, “Microsoft Access Basics.”

2. In the Database window, click the Table button, and then choose the New  
button.

Click here if tables aren't listed.

Click here to create a new table.

■ m
Table

Tables

Query

m
(OH Customers
ÖÜ] Employees
HÜ Order Details
HÜ] Orders

Microsoft Access displays the New Table dialog box.

3. Choose the Table Wizards button.

Microsoft Access displays the first Table Wizard dialog box.

4. Make the following choices as you go through the dialog boxes. To display the 
next Table Wizard dialog box, choose the Next button.

■ Select Business to display the list of business-related tables (the default).
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■ Select Events as the sample table, and add the following fields from the 
Sample Fields list to the Fields In My New Table box: EventID, EventName, 
Status, StartDate, and EndDate.

■ In the next dialog box, give your table the name Trade Shows.

■ Let Microsoft Access set the primary key field.

For maximum efficiency, Microsoft Access needs a way to tell one record in 
your table from the next— to uniquely identify each record. A table’s 
prim ary key is a field or set of fields that serves this purpose.

■ In the next dialog box, select the row that says your table is not related to the 
Employees table, and then choose the Change button. Define the relationship 
so that one record in the Employees table will match many records in the 
Trade Shows table.

While you’re looking at records from the Trade Shows table, there might be 
times when you’d like to see the employee representatives’ names and phone 
numbers as well. In the Northwind database, this data is stored in the 
Employees table. One employee could be assigned to more than one trade 
show, so one record in the Employees table could have more than one 
matching record in the Trade Shows table. In Part 3, “Working with Data,” 
you’ll see how Microsoft Access uses relationships to make it easier to view  
data from more than one table at the same time.

■ In the next dialog box, choose to modify the table design, and then choose 
the Finish button.

M
Field Name 1 Data T vpe I Description è

St C o u n te r
E v e n t N a m e T e x t “
S ta tu s T e x t
S ta r tD a te D a te / T i m e
E n d D a t e D a te / T im e

—
E m p lo y e e  ID N  um b er T

Field Properties

Format -

Caption E v e n t  ID
Indexed Y e s  ( N o  D u p lic a te s )

A  field n a m e  c a n  b e  u p  to 6 4  c h a ra c te rs
lo n g , inclu d ing s p a c e s  P re s s  F I  for help

o n  field n am e s

M ore  In fo rm a tio n  For guidelines on choosing a table’s primary key and a detailed 
explanation of the types of relationships you can create between tables, see Chapter
2, “Designing a Database,” in the Microsoft Access User's Guide. For instructions 
on setting primary keys and creating relationships between tables, see Chapter 7, 
“Table Basics,” also in the M icrosoft Access User's Guide.
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Plan Fields and Data Types
Now you’re ready to add the remaining fields to your table. To add a field, you’ll
enter a field name and choose a data type:

■ The fie ld  name identifies the data stored in a field. A field name can contain up 
to 64 characters, including spaces. (That’s true of all object names in Microsoft 
Access. For a list of characters that can’t be used in object names, choose 
Search from the Help menu and search for “naming conventions.”)

■ The data type tells Microsoft Access what kind of data goes in the field, such as 
text, numbers, dates, or currency.

N o te  You’ll create the rest of the fields for the Trade Shows table by adding them 
to the table in Design view. However, you can use the Table Wizard to create all 
the fields you need when you create a table, by changing the names of sample 
fields. To change a field’s name in the Table Wizard, add any field from the Sample 
Fields list, select that field in the Fields In My Table list, and then edit its name in 
the text box below the list. Later, if necessary, you can change the field’s data type 
and other properties in Design view.

When you add a field to your table, the most important question to ask yourself is 
what data type to give the field. Microsoft Access uses the data type to decide how 
much storage space to give the field and to ensure that the right kind of data is 
entered in the field. For example, Microsoft Access doesn’t accept text, such as a 
name, in a Currency field.

It’s important to choose the right data type for a field before you start entering data 
in the table. You can change a data type of a field that already contains data, but if 
the data types aren’t compatible, you may lose data.

So far, the Trade Shows table has fields with these data types:

■ The EventID field has the Counter data type, which stores sequential numbers 
created by Microsoft Access. Use the Counter data type to create a unique 
identifier for each record in a table.

■ The EventName and Status fields have the Text data type, which is used for 
words (such as names), for combinations of words and numbers (such as 
addresses), and for numbers that aren’t used in mathematical calculations (such 
as telephone numbers).

■ The StartDate and EndDate fields have a Date/Time data type, which is used for 
dates and times.
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■ The Employee ID field has the Number data type, which is used for numbers 
that can be used in mathematical calculations, and also for fields that are related 
to other Number fields or to Counter fields. In this case, the Employee ID field 
is related to the Employee ID field in the Employees table, which is a Counter 
field.

To complete the Trade Shows table, you’ll add fields with these data types:

■ The Fee field has the Currency data type, which is used for currency values such 
as francs, dollars, or yen.

■ The Vendor field has the Yes/No data type, which is used for yes or no, true or 
false values.

■ The Location field has the Text data type, as do EventName and Status.

M ore  In fo rm a tio n  For details about data types, click in the Data Type column and 
press f i .

In My Case: What Fields Belong in My Table?
You can think of fields as characteristics or attributes of the subject that the 
table represents. Sometimes an existing form, such as the trade show 
tracking sheet, can help you decide which fields you need. But often a form 
contains information about different subjects. For example, an order form 
might contain information about the order, about the customer who placed 
the order, and about the products that the customer ordered. Information 
about different subjects belongs in different tables. Here are two good 
questions to ask yourself when deciding what fields belong in your table:

■ Is the information a characteristic of the table’s subject or of something 
else? If it’s really a characteristic of something else, it doesn’t belong in 
the table.

■ Is it information that’s already stored in another table? If so, don’t repeat 
it. In Part 3, “Working with Data,” you’ll see how easy it is to bring 
together data that’s stored in different tables so that you can view it in the 
same place.
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Add Fields to the Table
The first field you’ll add to the Trade Shows table contains the amount o f the fee for 
participating as a vendor in the show. You need this information so that you can 
track the cost of attending various shows.

► To add a field

1. Type Fee in the first empty box under Field Name.

F" Table: Trade Shows 1
Field Name 1 Data Type 1 Description

T EventlD Counter
EventName Text
Status Text
StartDate Date/Time
EndDate Date/Time
Employee ID Number

► Fee

2. Press t a b  to move to the Data Type box.

Microsoft Access gives the field a Text data type. However, the Fee field will 
contain currency values, so you need to select the Currency data type.

3. In the Data Type box, select Currency. (To open the list, click the arrow or press
ALT+DOWN ARROW.)

4. Press t a b  to move to the Description box.

A short description for each field helps you remember the purpose of the field. A 
field’s description appears in the status bar in Datasheet view when the field is 
selected. Later, when you create a form for entering data in the table, you’ll see 
how field descriptions can also help you enter your data in forms.

5. Type Registration fee in the Description box.

That’s it. You’ve added the seventh field to your table.

T a b l e : T n d e ^ ( i i i i s
Field Name 1 Data Type I Description

T EventlD Counter
EventName Text
Status Text
StartDate Date/Time
EndDate Date/Time
Employee ID Number

► Fee Currency Registration fee
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Use the information in the following table to add the Vendor field.

Field name Data type Description

Vendor Yes/No Is North wind Traders a vendor?

Tip To choose a data type quickly, type the first letter of the data type you want in 
the Data Type box. Microsoft Access fills in the rest o f the data type for you. You 
need to type “co” for the Counter data type because both the Currency and Counter 
data types begin with “c.”

You’ll let the Field Builder add the last field for you.

6. Using the right mouse button, click in the next empty box under Field Name.

Microsoft Access displays a shortcut menu that contains commands appropriate 
for designing tables.

7. Choose Build from the shortcut menu.

Microsoft Access displays the Field Builder.

8. In the Sample Tables list, choose Events, and then double-click the Location 
field in the Sample Fields list.

Microsoft Access adds the Location field to your table.

9. Type City where the show is to be held in the Description box for the Location 
field.

Notice that the Employee ID field name contains a space, but the other field names 
provided by the Table Wizard don’t contain spaces. Field names in the Northwind 
database contain spaces so that the names are easier to read in examples. The 
Employee ID field that the Table Wizard added contains a space to match the name 
of the Employee ID field in the Employees table. It’s good practice to use identical 
field names for corresponding fields in a database, because doing so allows 
Microsoft Access to join tables in a query automatically.

The Table Wizard provides field names without spaces for three reasons: First, not 
all database systems permit spaces in names, so your Microsoft Access database is 
more portable if its field names don’t include spaces. Second, field names without 
spaces are more convenient to type in expressions and Access Basic procedures, 
because you don’t need to enclose the names in brackets. Finally, some database 
designers prefer not to include spaces in field names, as a design convention.
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Set Field Properties
Each field in a table has a set o f properties. By changing a field’s properties, you 
can control how Microsoft Access stores, handles, and displays data in the field. 
For example, you might want your data displayed in a particular format — 
numbers in scientific notation, perhaps, or dates with the month’s name 
abbreviated. The Format property controls how data is displayed in datasheets, 
forms, and reports.

Format 
Input Mask 
Caption 
Defat* Value 
VaSdation Rule 
Validation Text 
Required 
Indexed

Medium Date-«--------- ^  I
99/99/00 07^ul-94
aa/aa/UU 12-0ct-94

17-Sep-94 
1 1 -Oct-94

No
No

Changing a field’s Format property doesn’t change how the data is stored in the 
database. It affects how Microsoft Access displays the data in a datasheet, form, 
or report.

Set the Format property for the StartDate and EndDate fields so that they display 
dates in the Medium Date format: 07-Jul-94.

► To set the Format property

1. Click any box in the row that defines the StartDate field.

Click this row... — :

Table: Trade Shows
Field Harne

EventID
EventName
Status
StartDate
EndDate
Employee ID
Fee

I Bâta»» I

Format 
Input Mask 
Caption

Counter
Text
Text
Date/Time
Date/Time
Number
Currency

Short Date 
99/99/00 
Start Date

...click the Format 
property box...

...and then click 
the arrow to 
set the property.

2 .

3.

Click the Format property box, and then select Medium Date. (Click the arrow 
to open the list.) Or, from the StartDate field, press F6  to go to the property 
sheet, and then press a l t + d o w n  a r r o w  to open the list.

Repeat steps 1 and 2 for the EndDate field.



Chapter 3 Creating a Table 49

The Table Wizard set the Input Mask property of the StartDate and EndDate 
fields to a date format based on the Country setting in your Windows Control 
Panel. An input mask makes it easy to enter data using a specific format. You’ll 
delete the Input Mask property setting in this case, so you can enter dates using 
any format.

► To delete a property setting

•  Select the setting for the Input Mask property of the StartDate field, and then 
press the Delete key. Follow the same steps to delete the Input Mask property 
setting for the EndDate field.

Now your table is complete. Save your work before you go on.

► To save a table

• From the File menu, choose Save (or click the Save button on the toolbar). 

Microsoft Access saves your table in the database.

In My Case: Why Would I Want to Set Field Properties?
Setting field properties can be a big time-saver in the later stages o f  
building a database because the forms and reports you create for viewing or 
changing data from the table inherit many of the properties. Your forms 
and reports work the way you want them to automatically, requiring less 
work from you. The field data type you select determines the properties 
that a field can have. By changing a field’s properties, you can:

■ Change the maximum size of the field.

■ Control how Microsoft Access displays data from the field.

■ Give the field your own default caption.

■ Give the field an input mask that provides a pattern for data entry.

■ Give the field a default value.

■ Set rules for the values Microsoft Access will accept in the field.

■ Speed up data searches on the field.

M ore  In fo rm a tio n  For more information about an individual field property, click 
the property and press fi . For more examples, see Chapter 8, “Changing and 
Customizing Tables,” in the Microsoft Access U ser’s Guide.
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Add and Save Records
Each table in your database has two views: Design view and Datasheet view. So 
far, you’ve been looking at the Trade Shows table in Design view. You add records 
to the table in Datasheet view, which presents the table in columns and rows, like a 
spreadsheet.

To switch to Datasheet view
•  From the View menu, choose Datasheet (or click the Datasheet View button on 

the toolbar).

Microsoft Access displays your table in Datasheet view, where you can add 
records of data. The insertion point is in the first field of the first record.

Table: Trade Shows
Event IP I Event Name I Status I Start Date I End Pate I

► To add a record of data

1. Press t a b  to move to the Event Name field.

After you begin typing in a record, Microsoft Access fills in a Counter field for 
you, so you don’t need to type anything in the Event ID field.

2. In the Event Name field of the first row, type World Foods

3. Press t a b  to move to the Status field.

4. In the Status field, type 3

The Status field contains a code that represents Northwind Traders’ status with 
respect to the Trade show (1 for Inquired, 2 for Applied, 3 for Confirmed, and 4 
for Attended). In Chapter 5, “Customizing Your Form,” you’ll create a list box 
control with these four choices.

5. In the Start Date field, type July 7,1994

You’re not limited to one format in the way you enter a date; Microsoft Access 
recognizes a number of ways to enter dates.

6 . Press t a b .

Note that when you leave the field, Microsoft Access formats the date as 
07-Jul-94 to conform to the Medium Date format you set in the Format property 
for the Start Date field.

7. In the End Date field, type July 14,1994
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8. Press t a b  to move to the Employee ID field, and type 7

9. Press t a b  to move to the Fee field, and type 3725

Microsoft Access is just as flexible in accepting different currency formats as in 
accepting different date formats. For example, when you type a Currency value, 
Microsoft Access accepts it whether or not you include the currency sign (such 
as $ for dollars or £ for pounds).

10. Press t a b  to move to the Vendor field, and type Yes

The Vendor field indicates whether Northwind Traders will attend the trade 
show as a vendor (which usually involves hosting a trade show booth) or as an 
attendee.

11. Press t a b  to move to the Location field, and type London 

You’re finished adding your first record.

► To save a record of data

•  Press t a b  to move to the first field in the second row.

You don’t need to do anything else to save your data. When you leave a record, 
either by moving to another record or by closing the table, Microsoft Access 
automatically saves the data.
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Edit Records and Close a Table
While adding the first record to the Trade Shows table, you may have noticed that 
Microsoft Access put a pencil symbol in the record selector of the current record 
and an asterisk in the record selector of the empty record.

r -  Record selectors

Tatte: Trade Sh
Event IP I Event Name I Status

1 World Foods] 
(Counter)

L The current record (changes not yet saved)

The pencil is called a record selector sym bol Microsoft Access displays it next to 
the current record if you’ve changed the data in the record but your changes aren't 
yet saved. If you haven’t changed the data in the current record, Microsoft Access 
uses a triangle as the record selector symbol.

» Table: Trade Stiowçl
Event ID I Event Name I Status I

► 1 World Foods 3
* (Counter)

L The current record (no pending changes)

The asterisk marks the empty record at the end of the table. As soon as you start 
typing this record, Microsoft Access moves the asterisk to the next empty record. 
To see how this works, add another record to the Trade Shows table.

► To add a second record

■ Add this record to the table:

Event Name: Gourmet Expo
Status: 1
Start Date: October 12 ,1994
End Date: October 17 ,1994
Employee ID: 6
Fee: 125
Vendor: No
Location: Paris
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If you want, after you finish adding the second record, you can experiment with 
adding and editing more records. Here are some editing tips:

■ To move to the next or previous field, press t a b  or sh if t+ ta b .

■ To select the current field or remove the selection from the current field, 
press F2.

■ To undo changes to the current field or record, press e sc .

■ To replace the value in a field with the value o f the same field in the previous 
record, press c t r l + \

After you finish experimenting, you can close the table.

► To close a table

•  From the File menu, choose Close.

Microsoft Access closes the table.

M ore  In fo rm a tio n  For more techniques for adding and editing data in a datasheet, 
choose Search from the Help menu and search for “datasheets: adding records” or 
“datasheets: editing data.” Or see Chapter 4, “Adding and Editing Data,” in the 
M icrosoft Access User's Guide.
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Delete, Insert, and Rearrange Fields in a Table
In a table’s Design view, you can easily review and edit all the fields in the table. 
You can delete fields or insert new fields wherever you want them. You can also 
rearrange fields to whatever order you want. Rearranging the fields in Design view 
rearranges the order of columns, or fields, in Datasheet view.

—  You can delete, insert, and rearrange fields in Design view.

«

DescriptionField Name 1 Data Type I
EventID Counter
EventName Text

► Location T ext City where the show is to be held
StartDate Date/Time
EndDate Date/Time

Use the Design View and Datasheet View buttons on the toolbar to switch between 
Design view and Datasheet view.

Suppose the paper form you use to enter data in the Trade Shows table shows the 
Employee ID last instead of in the middle of the fields. You’ll move the Employee 
ID field to the end of the fields in the table.

► To rearrange fields

1. Open the Trade Shows table in Design view and then select the row for the 
Employee ID field by clicking its row selector.

2. Click the row selector again, hold the mouse button down, and then drag the row 
down to the end of the list.

3. When the pointer is where you want the row placed, release the mouse button. 

Microsoft Access moves the field.

As it is, you don’t need to delete or insert fields for the Trade Shows table. But you
can delete or insert fields in a table at any time.

► To delete a field

1. Open the table in Design view.

2. Select the row that defines the field you want to delete by clicking its row 
selector. (Or use the arrow keys to move to the row you want to delete, and then 
press S H IF T + S P A C E B A R .)
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-  Row selector (Click here to select the row.)

Field Name 1 Data Type 1 Description
EventID Counter
EventName Text
Location Text City where the show is to be held
StartDate Date/Time
EndDate Date/Tirne
Status Text
Fee Currency Registration fee
Vendor Yes/No Is Northwind Traders a vendor?
Employee ID Number Employee representative

-> Supplier ID Text Suppliers to meet with at show

3. From the Edit menu, choose Delete Row (or press the Delete Row button on the 
toolbar).

Microsoft Access deletes the field and all its data from your table.

To insert a new field above an existing field

1. Click the row above which you want the new row to appear (or use the arrow 
keys to move to the row).

2. From the Edit menu, choose Insert Row (or press the Insert Row button on the 
toolbar).

Microsoft Access inserts an empty row above the current row.

3. Define your new field in the empty row.

More Information For instructions on rearranging fields by using the keyboard 
instead of the mouse, choose Search from the Help menu and search for “tables: 
keyboard guide.”



56 Part 2 Building a Database

Resize Columns and Rows and Move Columns in a 
Datasheet

In Datasheet view, you can resize columns and rows and move columns to fit your 
immediate needs, similar to the way you can edit a spreadsheet. In addition, you can 
save your layout so that Microsoft Access always displays the datasheet the way 
you want it. For example, the event names in the table are shorter than the space 
provided in the EventName column. You decide to save space by resizing the 
EventName column in the datasheet to fit the event names in the table.

r- You can resize any column.
I ------1

1 Event Name I I Event Name]
World Foods World Foods
G ourmet E xpo G ourmet E xpo

If you later get an event with a longer name, you can always widen the column 
again.

► To resize a column to fit the data it contains

1. Open the Trade Shows table in Datasheet view.

2. Double-click the right edge of the fields selector (column heading) of the Event 
Name column.

Microsoft Access resizes the column to fit the data.

► To resize rows in a datasheet

1. Position the pointer on the border of any record selector.

The pointer changes to "i" to show that the border can be moved up or down.

2. Drag the border down to make all the rows taller. Drag it up to make all the 
rows narrower.

-  When the pointer changes shape, drag the border to resize the row.

a

Event ID I Event Name
1 World Foods
2 Gourmet Expo

► (Counter)

3. When the row is the size you want, release the mouse button. Microsoft Access 
resizes all the rows.
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You can change the order of columns in the datasheet just as easily. For example, 
suppose that you want to position the Location column before the Status column.

► To reorder columns

1. Position the pointer on the field selector (column heading) of the Location 
column.

The pointer changes to 4- to show that you can select the column.

2. Click the field selector to select the column.

3. Click the field selector again, hold the mouse button down, and drag the column 
to the left, over the Status column.

When the pointer changes J  
shape, drag the column to 
its new position.

4. When the pointer is where you want the column placed, release the mouse 
button.

Microsoft Access reorders the columns.

► To save your datasheet layout

•  From the File menu, choose Save Table.

Microsoft Access displays the datasheet in this layout the next time you open it.

More Information For information about how to use the keyboard instead of the 
mouse to move columns and to resize columns and rows, choose Search from the 
Help menu and search for “columns: datasheets.”
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Print, Minimize, Restore, and Close a Table
You use the same techniques to print, minimize, restore, and close a table that 
you’d use in any standard application for Windows. Use these techniques for any 
Microsoft Access object.

► To print a table

1. With the table open in Datasheet view, choose Print from the File menu (or click 
the Print button on the toolbar).

Microsoft Access displays the Print dialog box.

2. Choose OK.

Microsoft Access prints the table.

More Information For more information about printing tables, choose Search from 
the Help menu and search for “printing.”

Tip You don’t have to open a table in order to print it. In the Database window, 
select the table you want to print, and then choose Print from the File menu.

If you want to move a table window out of the way without closing it, you can 
minimize it.

► To minimize a table

• Click the Minimize button in the upper-right comer of the table window.

I End Pale
14-Jul-94 

17-0ct-94

■ Click here.

Microsoft Access minimizes the table to an icon and places the icon at the bottom 
of the Microsoft Access window.
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► To restore a table

• Double-click the table icon in the Microsoft Access window.

• Double-click here.

When you finish using the Trade Shows table, close it.

► To close a table

• From the File menu, choose Close (or double-click the Control-menu box in the 
upper-left comer of the table window).

If you’ve made changes to the table design or layout since last saving it, 
Microsoft Access prompts you to save the changes. Choose the Yes button.
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Import Data
In the past, you may have found it challenging to bring data stored in various files 
and file formats— such as spreadsheet files, text files, or other database files— 
together in one place. This can be especially true when your data is stored in 
different locations, such as PCs, networks, minicomputers, and mainframe 
computers. Microsoft Access provides two convenient methods for using data that’s 
stored outside your Microsoft Access database:

■ Attaching an external table You can use Microsoft Access to view and 
update data in a different Microsoft Access database or in a different database 
file format— such as dBASE, Paradox, Btrieve, or SQL Server— without 
copying or moving the data from its source. To do that, you attach the external 
table to your Microsoft Access database. Microsoft Access uses special icons in 
the Database window for external tables.

You can use Microsoft Access to view data in an external table just as you 
would in a Microsoft Access table; the difference is that the data is stored 
outside your Microsoft Access database. This is convenient because you can use 
Microsoft Access to view, change, and combine information from many sources. 
In addition, at the same time you’re using Microsoft Access to work with data in 
an attached Paradox file, someone else could be using Paradox to work with the 
same data. For more information on attaching external tables, see Chapter 9, 
“Importing, Exporting, and Attaching,” in the Microsoft Access User's Guide.

■ Importing data You can also import data from a wide variety of file formats 
into a Microsoft Access table, including spreadsheet files, text files, and other 
database files. When you import data, you copy the data from its source into a 
new Microsoft Access table.

For example, suppose that the Northwind Traders sales manager receives a 
dBASE IV file that contains possibilities for new customers for Australian 
products. You want to use Microsoft Access to view the data in the file. You can 
attach the external dBASE file to your Microsoft Access database, in which case 
the data stays in the dBASE file. If you choose to import the data instead, Microsoft 
Access copies the data into a new Microsoft Access table.

Attaching and importing involve similar steps. In the following procedure, you’ll 
import the dBASE file into a new Microsoft Access table. When you set up 
Microsoft Access, the Microsoft Access Setup program copied a sample dBASE IV 
file to the Microsoft Access directory for you to use.
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To import a table

1. In the Database window, choose Import from the File menu. 

Microsoft Access displays the Import dialog box.

2. From the Data Source list, select dBASE IV.

- f
Data Source:

Lotus (WK1) 
Lotus (WK3) 
Paradox 3.X 
Paradox 4.X 
FoxPro 2.5 
FoxPro 2.0 
dBASE III

Btrieve
<SQL Database>

OK

Cancel

If dBASE IV doesn’t appear in the list, then the dBASE IV driver wasn’t set up 
when Microsoft Access was set up on your computer. To set up the driver, run 
Setup, and choose Add/Remove. Click ISAM Options, and then choose the 
Change Option button. Select the dBASE and FoxPro ISAM.

3. Choose OK.

Microsoft Access displays the Select File dialog box, where you select the 
dBASE file you want to import.

4. In the File Name list, select NEWCUST.DBF.

5. Choose the Import button.

Microsoft Access creates a table, names it Newcust, and adds the dBASE data 
to it.

6. Choose OK when Microsoft Access tells you that the table has been 
successfully imported, and then choose the Close button to close the dialog box.

Microsoft Access displays the new table in your Tables list.

You can view the data in the new table and change it the same way as in other 
tables in your database. Because you imported this data, your changes will have no 
effect on the original dBASE IV file.
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What’s Next?
Congratulations! You’ve created a table, defined its fields, and added two records 
of data. In addition, you’ve imported data from a dBASE IV file into your 
Microsoft Access database.

In the next chapter, you’ll learn how to create a form and use it to add more data to 
your table.
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Creating a Form

In this chapter, you’ll learn how to create a form, how to use it to view data and add 
new records, and how to print it.

Chapter Contents
Create a Form with a Form Wizard 
Use a Form to View Records 
Add and Save Records with a Form 
Print, Save, and Close a Form 
W hat’s Next?

The Challenge You’ve created a table and added a couple of rows of data using 
the datasheet, but now you’d like a more convenient layout for viewing and editing 
data.

The Approach You’ll create a form based on the Trade Shows table that shows 
all the fields in a column. After you create the form, you’ll use it to add more 
records to the table, and then you’ll print the form to show your records.
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Create a Form  with a Form Wizard
Suppose that you’d like to see the fields from the Trade Shows table arranged more 
like the printed tracking sheet than like a spreadsheet. To view and change your 
data in a layout other than the datasheet, you can use a form.

Note If you haven’t created the Trade Shows table described in Chapter 3, select 
another table such as Products or Suppliers to practice creating a form and entering 
data.

It’s easy to create a Microsoft Access form. In fact, with a few instructions from 
you, a Form Wizard can create it for you. To create the Trade Shows form, you’ll 
use AutoForm, which builds a simple form automatically.

Other Form Wizards provide a variety of layouts and styles for you to choose from. 
They prompt you with questions about the form you want and then build the form 
based on your answers. After using a Form Wizard to create your form, you can 
modify it if you like.

► To create a form by using a Form Wizard

1. In the Database window, click the Form button.

Click here.

Query

Report

I I  Add Products
(HI Categories
HI Categories Subform
(HI Country Filter Dialog
HI Customers
I I  Daily Order Totals
ID Employees



Chapter 4 Creating a Fo rm  65

Microsoft Access displays the list of forms in the Northwind Traders database.

2. Choose the New button (or choose New from the File menu, and then choose 
Form).

r  Click here.

M i
New I Open ~j Design

Forms
HI Add Products
[H Categories
HI Categories Subform
fig] Country Filter Dialog
ID  Customers

Microsoft Access displays the New Form dialog box.

=1
Select A Table/Query:

1 a

11̂ □

FortnWizards ¿.lank Form

1 Caned |

3. Under Select A Table/Query, select Trade Shows.

4. Choose the Form Wizards button.

Microsoft Access displays the first Form Wizard dialog box.

5. Select AutoForm.

6. Choose OK.

AutoForm creates the form and opens it for you. The form shows the first record 
in your table.

0 Tip You can also create a form by selecting a table in the Database window and
then clicking the AutoForm button on the toolbar.
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Use a Form to View Records
Now you have a form that you can use to view, change, add, and delete records in 
the Trade Shows table. Take a minute to look at the way Microsoft Access displays 
information on a form.

a

Trade Shows ---------Label
► EventID i m

EventName |World Foods |

Status [3 1 ---------Text boxes with
Start Date | 07\Jul-94|

attached labels
End Date | 14-Jul-94|

Fee | $3,725.00 |

Vendor Ix Check box with
Location ¡London | attached label

Enplofee ID I A

The objects on the form are called controls. In some ways, you use them like the 
controls and screen on a television set. But, instead of changing a channel or 
watching a show, you use Microsoft Access controls to change and view your data. 
Microsoft Access places three kinds of controls on your form:

■ A label displays text such as a title, caption, or message.

■ A text box provides an area where you can display or type text or numbers that 
are stored in your database. Fields such as EventID, EventName, Status, and 
StartDate are displayed in text boxes.

■ A check box indicates a condition— either checked (selected) or unchecked 
(cleared). The Vendor field is a check box. Form Wizards automatically create 
check boxes for fields with the Yes/No data type.

There are a variety of other controls you can add to Microsoft Access forms as 
well, including controls that display lists, contain pictures, or carry out actions. In 
the next chapter, “Customizing Your Form,” you’ll learn how to add various 
controls to your forms.

Microsoft Access forms provide two views of your data: Form view and Datasheet 
view. Form view is often the best way to see all the fields in a single record at the 
same time, without scrolling. On the other hand, Datasheet view is a convenient 
way to view many records in your table at once. You can use the toolbar to switch 
between the two views.
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► To switch to Datasheet view

• From the View menu, choose Datasheet (or click the Datasheet View button on 
the toolbar).

Microsoft Access displays the form’s data in Datasheet view. Note that the 
Vendor column has check boxes in it, like the check box on the form. (Scroll the 
datasheet horizontally to see all of its fields.)

» Trade Shows 7i
Event ID: I Event Name: I Status: I Start Date: I End D aw

T
1 World Foods
2 Gourmet Expo 

(Counter)

3 07-Jul-94 Â|/ 
1 12-0ct-94 17//

Ifcife Shorn
I

14 Jul-94 $3,725.00 
17-0c<-94 $125.00

$0.00

Vendor I Location: I Employee II
London
Paris

To switch to Form view
• From the View menu, choose Form (or click the Form View button on the 

toolbar).

Microsoft Access returns to Form view.

You view a record in Form view by moving to the record you want to see.

To move from record to record on a form

• Use the navigation buttons in the lower-left comer of the window to go to the 
first, last, previous, or next record.

r  Shows the number of the current record

Vendor: I*

Location: | London |

Enployee ID: [

of 2 ¡H !
L  Go to the previous record. 

L  Go to the first record.

rGo to the last record. 

L  Go to the next record.

You can also use the Go To command on the Records menu to move from record 
to record on a form.

More Information To see keyboard techniques for navigating through records, 
choose Search from the Help menu and search for “forms: navigating.”
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Add and Save Records with a Form
There are two new trade shows to add to the database. You’ll type the data for the 
records in blank forms.

► To add a new record

From the Records menu, choose Go To, and then choose New (or click the New 
Record button on the toolbar).

Microsoft Access displays the blank form at the end of the records and 
highlights Counter in the first text box, Event ID. Because Event ID has a 
Counter data type, Microsoft Access will fill it in for you automatically.

Press t a b  to move to the Event Name text box.

In the Event Name text box, type International Food Fair

In the Status text box, type 2

Use the t a b  and s h i f t +t a b  keys to move forward and backward through the 
fields. (Or you can move directly to a field by clicking it.)

In the Start Date text box, type September 17,1994

Notice that when you move out of the Start Date text box, Microsoft Access 
displays the date in the Medium Date format you set for the field in Chapter 3.

Fill in the rest of the record with the following information:

End Date: September 22,1994
Fee: 225
Vendor: Checked (press the s p a c e b a r  or click the Vendor text box

to check it)
Location: Sydney 
Employee ID: 1

As you move to the Fee, Vendor, and Location fields, note that Microsoft 
Access displays the description you wrote for each field in the status bar.

► To save a record

• Press t a b  to move to the next record.

As soon as you leave the record, Microsoft Access saves it in the Trade Shows 
table. You don 7 need to do anything else to save the data. If you want to save a 
record without leaving it, choose the Save Record command from the File menu.

2 .

3.

4.

5.

6.
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► To add another record

• Use the form to add this record to the Trade Shows table:

Event Name: 
Status:
Start Date: 
End Date: 
Fee:
Vendor:
Location:

Internationale Lebensmittelmesse
3
October 11,1994 
October 18,1994 
200
Cleared (not checked)
Hamburg

Employee ID: 1

If you make a mistake or change your mind while adding or editing data, Microsoft 
Access makes it easy to undo your changes.

► To undo your most recent change in a field before you leave the field

• From the Edit menu, choose Undo Typing (or click the Undo button on the 
toolbar).

Microsoft Access undoes your most recent change in the field. You can undo all 
changes in a field before you leave it by choosing the Undo Current Field command 
from the Edit menu, or by clicking the Undo Current Field/Record button on the 
toolbar.

More Information For details on how the Undo button and Undo command work, 
choose Search from the Help menu and search for “undo changes.” For more 
techniques for adding and editing data on a form, see Chapter 4, “Adding and 
Editing Data,” in the Microsoft Access User's Guide.
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Print, Save, and Close a Form
Before closing your form, you’d like to print the records in the Trade Shows table 
as they appear on the form.

You can use Print Preview to see how your form will look in print before you 
print it.

More Information For information about setting up Microsoft Access for printing, 
choose Search from the Help menu and search for “printing.”

To preview how a form and its data will look on a page

1. Click the Print Preview button on the toolbar (or choose Print Preview from the 
File menu).

Microsoft Access displays your form and its data as it will look in print.

2. To zoom in on the page, position the pointer over the page so that it turns into a 
picture of a magnifying glass, and then click (or click the Zoom button on the 
toolbar).

To return to a view of the entire page, click the form again (or click the Zoom 
button again).

You can print your form from Print Preview or Form view.

To print a form

1. From the File menu, choose Print (or click the Print button on the toolbar). 

Microsoft Access displays the Print dialog box.

2. Choose OK.

Microsoft Access prints the form along with its data.

3. From the View menu, choose Form (or click the Close button on the toolbar) to 
return to Form view.

Now you can save and close the form.
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► To save a form

1. From the File menu, choose Save Form.

Microsoft Access displays the Save As dialog box.

2. Type Trade Shows and then choose OK.

Microsoft Access saves your form.

► To close a form

• From the File menu, choose Close (or double-click the Control-menu box in the 
upper-left comer of the Form window).

Microsoft Access closes the form. Note that your new form is now listed in the 
Northwind Database window.

Now your form is part of the Northwind database. You can open it, revise it, and 
use it anytime you want.
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What’s Next?
You’ve created a form, used it to view and add records to your table, and printed 
records as they appear on the form.

In the next chapter, you’ll modify and improve the appearance of your form. In 
addition, you’ll customize the form so that you can enter new records easily and 
without errors.
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Customizing Your Form

73

In this chapter, you’ll learn how to place, move, and resize controls on forms and 
how to display values in a list. In addition, you’ll learn how to show a default value 
in a control so that the field has that value automatically for each new record.

Chapter Contents
Change a Form’s Design 
Select and Resize Controls 
Move Controls
Move Controls and Attached Labels Separately
Add a Label and Edit Label Text
Change the Appearance of Text
Display Values in a List
Set Control, Section, or Form Properties
Display a Description in the Status Bar
Make Your Form Work for You
What’s Next?

The Challenge You’ve used your form to enter new records and to print records. 
Now you’d like to change its appearance so that it looks more like the original trade 
show tracking sheet.

The Approach You use the form’s Design view to move controls and adjust how 
the form looks and works. By the time you finish, you’ll be able to use your form 
both to add new records and to send information about trade shows to employees.
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Change a Form ’s Design
Now that you’ve used your form to add a few records, you’ll find that you can use 
your form for yet another purpose. You can send a printed copy of the form to the 
employee who will be attending the show. You decide to make the form look more 
like the original trade show tracking sheet.

1
Trade Shows

► Event ID: 1 D
Event None: |World Foods

Status: |3

Start Date: | 07-Jul-94|

End Date: | 14-Jul-94|

Fee: | $3.725.00 |

Vendor (x

Location: | London |

Employee ID: I 1

You will change this form...

I
Trade Shows

|World Foods | 
Event Name

a
Event ID

| 07-Jul-94| | 14-Jul-94|
Start Date End Date

| London |
Location

(3 | $3,725.00
Vendor Fee

Questions?CattLaura I
CaSahan atX 23441

l<l'<|Flecofd:|l I of 4 e e e

1 Inquired
2 Applied

Employée I

..to look like this.

You change the appearance of a form in the form’s Design view. You can open 
your form in Design view from the Database window.

► To open a form in Design view

1. In the Database window, select the Trade Shows form. (If necessary, click the 
Form button to display the list of forms.)

2. Choose the Design button.

*  *

N e w  | O p e n  | D e s ig n  - | —

B
I Table

\ m

F o r m s
[H Product List 
( H  Products hi

Microsoft Access opens the form in Design view.
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In Design view, 
Microsoft Access 
displays the field name 
in the text box.

Note that Microsoft Access divides the form into three sections in Design view:

■ The form header contains the label “Trade Shows.” When you’re viewing data, 
the form header appears once at the top of the window.

■ The detail section contains the fields from the Trade Shows table. When you’re 
viewing data, the detail section is repeated for each record. When you print the 
form, the detail section shows as many records as will fit on a page.

■ The form footer is currently blank. When you’re viewing data, the footer 
appears once at the bottom of the window.

All forms have a detail section, but not all forms have a form header and footer. To
add these sections to a form, choose the Form Header/Footer command from the
Format menu.

Note A form can have two additional sections— a page header and a page footer. 
These sections appear only on the printed form and not when you’re viewing data 
on the screen. Use the Page Header/Footer command on the Format menu to add 
these sections.

«
01... I... 1... I l 1... I... I...|2..1... I... 1... l 3 1... I... 1... |4...... I... I... I♦
¿"Form Header

Q-
Trade !Shows

¿"Detail
0- 1 1tver: : : : ■ i __;.i Event N

it ID:- tventlD ...........
i ... : i 1 .........

----- h

♦

.........  Status:- |Status |
......- i : ‘ ......... '...... Start Date:- |StartDate |...............

1 ......  End Date:- lEndDate 1.............
: : : : . " 1 :...........  Fee:- |Fee ......

Vendor:- [* •........ t .........
......  Location:- |Location |......

2- I I 
■ • ■ Employee ID:- |Emp!oyeelD |......

¿“Form Footer

♦Ü \±
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Select and Resize Controls
Controls are the objects on your form that display data from a field or words in a 
title. In Design view, you can select, resize, move, and otherwise manipulate the 
controls on a form.

To select a control
• Click the EventID text box. (Make sure to click the text box and not its attached

label.)

Ü Move handles

Event ID: ven tID  ----- s.
Size handles

Attached label Text box

When you select a control, Microsoft Access displays size and move handles 
around the control:

■ Drag the handles on the top and bottom to size the text box vertically.

■ Drag the handles on the left and right sides to size the text box horizontally.

■ Drag the handles in the comers to size the text box both vertically and 
horizontally.

■ In controls with attached labels, use the move handles to move each part 
separately.

The value in the EventID field will never be longer than three digits, so the text box 
doesn’t need to be as large as it is. You can change it to a more appropriate size.
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► To resize a control

1. Position the pointer as shown in the following illustration.

^ E v e n l ID:f ^  ventlD ¡7?
When the pointer looks like this, you can resize a control.

2. Drag the border to shorten the text box. When the box is the size you want, 
release the mouse button.

You can also select more than one control at a time. This is a convenient method for 
moving or aligning a group of controls.

► To select more than one control

•  Position the pointer beside (not on) one of the controls you want to select, and 
then drag diagonally through all the controls you want to select.

While you drag, Microsoft Access draws a rectangle around the controls. When 
you release the mouse button, all the controls in or touching the rectangle are 
selected. (You can also select a group of controls by holding down the s h i f t  key 
while you click each control.)

More Information For more information about selecting multiple controls, choose 
Search from the Help menu and search for “selecting controls.” For information 
about aligning controls, search for “alignment: controls.”
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Move Controls
All the text box controls on your form have attached labels. You can move a control 
and its attached label together, or you can move them separately. You’ll rearrange 
the controls on the Trade Shows form so that they’re positioned with the labels 
below the controls, more like the items on the trade show tracking sheet.

J i . i . i . i . i . i . i . h i . i . i . i . i . i . i . t e i . i . i . i . i . i . i . f a i . i . i . i . i . i . i . k i . i . i . i . i . i . i . l —
rF o im  Header

0-
Trade>hows

¿"Detail

| EventName
_L

Event Name:-

I Star (Date |EndDate '

Employee ID
Employee ID: i

Start by moving the EventID control next to the EventName control.

► To move a control
1. If the EventID control is selected, click outside the control to cancel the 

selection.

2. Position the pointer anywhere on the EventID control, and hold down the mouse 
button.

The pointer changes to .

Event ID:[ EventIDI----- p ----1----- ^

3. Drag the control so that it’s next to the EventName text box.

Note that Microsoft Access moves the text box and its attached label together.

4. When the control is positioned where you want it, release the mouse button.

E ventN am e
r.

EventID:] jjE v e n tjp
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Tip You can also move a control that’s already selected without canceling the 
selection. Position the pointer on the border of the selected control but not over a 
size handle or move handle. The pointer turns into a hand. While the pointer is this 
shape, you can drag the control where you want it.

Next, lengthen the detail section, and move the controls farther apart.

► To lengthen a section

1. Position the pointer on the border between the detail section and the form footer.

2. Drag the border down to lengthen the section.

► To move controls

• Drag the remaining controls farther apart on the form.

In the next section, you’ll move the EventName label so that it appears below the 
text box.

Employee ID:f Em ployee ID

Footer

When the pointer looks like 
this, drag the border down.
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Move Controls and Attached Labels Separately
When you move a text box, its attached label moves with it. You can also move a 
control or its attached label separately. To do that, you use the move handles.

_______p  Move

K_ J  ~ ~ -l Event Name: r
I '

Now you’ll move the attached labels so that they’re positioned below the text boxes 
instead of beside them.

► To move the attached label separately
1. Select the EventName control.

2. Position the pointer over the label’s move handle.

When the pointer is over the handle, it changes to ^ .

3. Drag the move handle to position the label below the text box.

^ventNarne1 \  
f Event Name:! ........... I ..............

~~1  .................... I ................

I-  Drag to here.

handles

L
ff iv e n tN a m e

4. When the label is where you want it, release the mouse button.
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► To practice moving controls

• Rearrange the controls on the Trade Shows form so that they’re positioned as 
they appear in the following illustration.

«=

¿“Form Header
0 :

Trade :> h d w $
^D etail

0 - .................... I ......................... i .........................
■ lEventName 1 ...........

Event Name:...................... EventID |. ■_ _ bventlU:

■ |StartDate • |EndDate | ......................  ......................
Start Date: End Date: .........................| Status

1 -
• | Location 1 ..............

Location:

i*
Vendor

: lFee . 1 Employee ID
Fee:- • • • | ......................  Employee ID:

2 - ...........  ........... I ............
...........1..............1............

When you move a control, note that the rulers display marks that indicate the 
position of the top, bottom, left, and right edges of the control. These marks help 
you to position the control.

More Information For more information about moving and positioning objects on 
forms and using the grid to align objects, see Chapter 14, “Form Basics,” in the 
Microsoft Access User's Guide.
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Add a Label and Edit Label Text
A label is a type of control you can place on your form to add information. By 
adding a freestanding label to the Trade Shows form, for example, you can tell 
employees who to call if they have questions about a specific trade show.

A freestanding label is not bound to a field (like a text box) or attached to a control 
(like a text box’s label).

Vendor:
Fee

Fee:

Questions? Call Laura 
Callahan at X2344

i Freestanding label

The first time you open a form in Design view, Microsoft Access displays the 
toolbox in the lower-left comer of your screen. You use the toolbox to place new 
controls on your form.

Pointer

Label 

Option Group 

Option Button 

Combo Box 

Graph

Unbound Object Frame 

Line 

Page Break

Control Wizards

- { A

- a

E  Toolbox

№

— N

-H I
SN

ab|

|x -

m -

Text Box 

Toggle Button 

Check Box 

List Box 

Subform

Bound Object Frame 

Rectangle 

Command Button

Lock

You can close or open the toolbox by choosing Toolbox from the View menu. You 
can also move the toolbox on your screen by dragging its title bar.
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More Information For details about each type of control, click the respective tool in 
the toolbox and press fi.

To draw a freestanding label

1. Click the Label tool in the toolbox.

2. Click where you want to place the label.

3. Type Questions? Call Laura Callahan at X2344 in the label.

As you type, Microsoft Access sizes the label to fit your text.

Now the label displays your text. Check to see how the label looks in Form view, 
and then switch back to Design view.

Now that the labels are positioned below the text boxes, the colons are no longer 
necessary.

To edit text in a label

1. Click the label attached to the EventName text box.

i ........................... I -

%
ven tN am e

■/Event Name^rt!-------- --------,—5J Click here.

Microsoft Access selects the label.

2. Click the label again.

E ventN am e

Event Na|ne:
Insertion point

Microsoft Access places an insertion point in the text of the label. Now you can 
edit the text.

3. Select the colon at the end of the text, and then press the DEL key.

4. Follow the same steps to edit the other labels.



84 Part 2 Building a Database

Change the Appearance of Text

a

Visual style in text can add important functional impact or aesthetic appeal to 
your form. To work on the visual style of the text, start by changing the text in 
your freestanding label to italic.

► To make text italic

1. Select the Questions? label.

When you select a label or a control that includes text, the toolbar enables 
additional tools for changing the appearance of the text.

r  Display the palette. £ Make the text bold or italic.

Sans Serif " i r a f i

Change the font and size. L Change the alignment.

2. Click the Italic button on the toolbar.

Microsoft Access changes the text in the label to italic.

3. From the Format menu, choose Size, and then choose To Fit.

Microsoft Access resizes the label to fit the new text.

You can make the label stand out on your form by giving it a three-dimensional 
appearance.

To change the visual style of a control

1. Select the label (if it isn’t already selected).

2. Click the Palette button on the toolbar.

Microsoft Access displays the palette.

3. In the palette, click the Raised Appearance button.

Raised Appearance button
L

e e q e e e is e e q
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Microsoft Access gives the label a three-dimensional appearance.

0  [ F e e  I
Vendor Fee

Questions? Caff Laura 
Caffahan atX2344

You can also use the palette to change a control’s fill color or its border weight 
and color.

4. To close the palette, click the Palette button on the toolbar (or click the palette’s 
Control-menu box).

To see how your new label looks, switch to Form view. When you finish viewing 
the form, return to Design view. Take time to experiment with different fonts, sizes, 
colors, and alignments for the text. Use the buttons on the toolbar or the options in 
the palette to make your changes. For example, now that the attached labels are 
under the controls instead of beside them, they’d look better with their text aligned 
left instead of aligned right. You can select all the attached labels on the form, and 
then click the Text-Align Left button on the toolbar to align their text to the left.

In My Case: How Do I Give My Form the Look I Want?
Because Microsoft Access provides so many choices for the appearance of 
controls on forms, you can give your form a personal and distinctive design. 
But it might take some experimenting to discover the look that works for you. 
It’s a good idea to start by trying out all the options— to find out everything 
you can do— and then focus on just a few choices. That’s because a form that 
uses 16 colors, 5 fonts, and a random mix of raised and sunken controls will 
turn out to be a mess!

Form Wizards offer a variety of styles, each with a distinctive, professional 
look. You might start by choosing a different style for each new form, just to 
see which you like. From these you can modify a style to suit your needs. 
Once you’ve changed a control to look the way you like, you can make its 
appearance the default so that each new control you create uses the same 
design automatically. For details on how to set defaults for controls, choose 
Search from the Help menu and search for “controls: properties.”
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Display Values in a List
The controls that you use to enter, update, and display data from a table or query 
are bound to fields in the table or query. Most of the controls on the Trade Shows 
form are bound to fields in the Trade Shows table.

f  Form Header
1 ! 

Trade Shows-— !—
f  Detail

0- i i
|EventName --- 1---------1---
1 Event Name; 1

Freestanding labels aren't bound to fields.

This text box is bound to the EventName 
field in the Trade Shows table.

The Status text box on your form displays the number for the trade show’s status 
level: 1 for Inquired, 2 for Applied, 3 for Confirmed, and 4 for Attended. You can, 
however, use a list box that shows both the number and the descriptive text for each 
level. That way, you can simply select the correct level from the list.

Your list box will replace the Status text box, so you can start by deleting that 
control. Then you’ll use the List Box Wizard to create the new list box control.

► To delete a control

1. Click the Status text box to select it.

jfttatus 1 j —  Click here.
Status i— -------j--------------

2. Press the d e l  key.

Microsoft Access deletes the text box and its label. To delete a label without 
deleting the text box, select the label and press the d e l  key.

Your list box will be bound to the Status field in the Trade Shows table. When you 
add a bound control to a form, your first step is to select the tool from the toolbox 
for the type of control you want.

To add a list box control to a form

1. From the View menu, choose Control Wizards (if the Control Wizards 
command does not display a check mark). Or click the Control Wizards tool in 
the toolbox so the tool appears sunken.

2. Click the List Box tool in the toolbox.
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3. Click the form where you want to draw the list box.

Microsoft Access displays the first List Box Wizard dialog box.

4. Make the following choices as you go through the dialog boxes:

■ Choose to type in the values for the list box.

■ Enter 2 as the number of columns, and, in the grid, enter the list box data 
shown below:

1 Inquired
2 Applied
3 Confirmed
4 Attended

■ Make Column 1 narrower, leaving room for only one or two digits.

■ Select Column 1 as the column that contains the value to store in your 
database.

■ Select Status as the field in which to store the list box’s value.

■ Give your list box the label Status.

5. Click the Finish button to create the list box control.

Microsoft Access displays the Trade Shows form with the new list box control 
selected. Switch to Form view to see the finished list box control, and then 
return to Design view.

Status 1 Inquired
2 Applied
3 Uonfirmed
4 Attended

Note Some database designers prefer to always use a table or query as the source 
of values for a list box or combo box, because a table or query can be used more 
than once and is easier to maintain. For more details, see Chapter 16, “Customizing 
Forms,” in the Microsoft Access User's Guide.
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Set Control, Section, or Form Properties
Each control on a form has a set of properties. Properties determine a control’s 
appearance and behavior. When you gave your freestanding label italic lettering 
and a three-dimensional look, you were setting properties for the label. To see and 
set control properties, you open the property sheet. The property sheet shows the 
properties of the selected object.

A form and each of the sections and controls it contains has its own set of 
properties. In the following procedure, you’ll display the properties for the Status 
list box.

To display the property sheet

•  From the View menu, choose Properties (or click the Properties button on the 
toolbar).

Microsoft Access displays the property sheet.

To see the properties of an object

•  With the property sheet open, click the Status list box. (Make sure to click the 
list box and not its attached label.)

Microsoft Access displays the properties of the Status list box in the property sheet. 
Try selecting different objects on your form:

■ To see the properties of an attached label, click the label.

■ To see the properties of a form section, click the background of the section or 
the section header.

■ To see the properties of the form, click the gray background of the form design 
window, outside the form sections (or choose Select Form from the Edit menu).

When you finish experimenting, click the Status list box again to display its 
properties.

You can leave the property sheet open while you work on your form. That way, you 
can simply select an object to view its properties.
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In My Case: What Can I Do with Properties in Forms?
By setting properties for your form, form sections, and controls, you can 
customize your form to look and behave just the way you want it to. When 
you combine settings for different properties, the possibilities become almost 
endless. For example, you can:

■ Choose to display some sections of your form only on the screen or only 
in print. In addition, you can choose to have a section shrink or grow to fit 
its data when it’s printed.

■ Print one record per page, or display one record at a time on the screen, 
instead of a continuous series of records.

■ Have Microsoft Access check the values you enter in a control and 
display a message if they aren’t valid.

■ Define a default value for a control that Microsoft Access fills in 
automatically for each new record.

■ Display the result of a calculation in a control.

More Information For examples of how to do these and other things with 
your forms, see Part 4, “Forms,” in the Microsoft Access User's Guide. For 
more information about any property, click the property in the property sheet 
and press fi.
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Display a Description in the Status Bar
In Form view, the status bar displays the descriptions you entered for each field 
when you originally created the Trade Shows table. Because the Status list box is a 
new control, it doesn’t have a description to display. You can define a description 
by setting the StatusBarText property for the list box.

Take a moment to look at a few of the other properties for the list box. The List Box 
Wizard set these properties when you created the list box:

■ The RowSourceType property tells Microsoft Access what type of source 
provides the values in the list: a table or query, a list of values you provide, or a 
list of fields.

■ The RowSource property identifies the source of the list. For example, if the 
RowSourceType property is set to Table/Query, you set the RowSource property 
to the name of the table or query that contains the values for the list.

■ The ColumnCount property determines how many columns are in the list box.

■ The ColumnWidths property determines the width of the columns.

Now set the StatusBarText property to the text you want to display in the status bar 
when the list box is selected in Form view.

► To set the StatusBarText property
1. While viewing the properties of the Status list box, select the StatusBarText 

property box.

Microsoft Access displays the insertion point in the box, indicating that you can 
enter a value.

2. In the StatusBarText property box, type Select the status of this trade show 

That's all it takes to set the property.

When you created the list box, you adjusted the width of the first column so that it 
was narrower than the second column. If you want to adjust the column again, set 
the ColumnWidths property.
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To adjust column widths in a list box
• In the ColumnWidths property box, type this value for the Status control: 

.25;.75

This sets the width of the first column to 0.25 inch and the width of the second 
column to 0.75 inch. (If your ruler measurement is set to centimeters, set the 
property to .5;2.)

That’s it. You’ve set properties for the list box.

Note that the BoundColumn property is set to 1. The first column in the list—the 
one that contains the numbers— is bound to the Status field in the Trade Shows 
table. The values displayed in the first column are those stored in the field.

Close the property sheet, and then check the appearance of your list in Form view. 
Scroll through the records in the table. In each record, the list shows the current 
value of the field. When you add a new record, you select the value from the list.

When you finish viewing the list box in Form view, return to Design view. If you 
want, you can resize the list box so that it fits the items in your list.
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Make Your Form Work for You
When you create a form that you or someone else will use to add, change, or view 
records, think about how you might want that form to work for you. Would you like 
to have Microsoft Access automatically fill in some of the values for each new 
record? Would you like to show the results of calculations in some controls? Would 
you like your form to display a message if you make a data entry error? You can do 
all this and more with Microsoft Access forms.

This chapter gives you a small sample of the possibilities in Microsoft Access 
forms. You’ve already seen how arranging controls can improve a form’s usability 
and how different types of controls can make your data easier to read and 
understand. Here are a few of the other things you can do with Microsoft Access 
forms. If you like, experiment with these features on the Trade Shows form.

Setting a Default Value
In some cases, one value might show up in a field more often than any other. For 
example, Nancy Davolio might be responsible for attending most of the trade 
shows.

When you add a new trade show, you can have Microsoft Access automatically fill 
in the Employee ID field with Nancy’s employee ID number. Just set the 
Default Value property for the control to 1.

You can also set the default value of a field when you design your table. Then 
Microsoft Access will automatically apply that value to any control you create 
that’s bound to the field.

Showing Calculations
A control that’s bound to a field in a table or query displays data from the field.
You can also use a control to display data that’s not in your tables. For example, 
you might want to display the current date in a text box on the Trade Shows form. 
The text box would not be bound to any field; instead, it would display the result of 
this expression: =Date(). The Date function returns the current date as reported by 
the system clock in your computer. A control that displays the result of an 
expression is called a calculated control.

To create a calculated control, select the tool in the toolbox for the control you 
want, and then click your form where you want the control to appear. Microsoft 
Access creates the unbound control. Now type the expression that you want in the 
control, or set the control’s ControlSource property to the expression.
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Creating Validation Rules
Validation rules help you ensure that information entered into a form is correct 
before Microsoft Access stores it in your tables. For example, Northwind Traders 
intends to hold a company-wide planning retreat during August, 1994, and no 
employees will be available to attend trade shows during that month. The values in 
the StartDate and EndDate fields should fall outside of that month; a date in that 
month is a mistake. You want Microsoft Access to catch errors like this and display 
a message that helps you fix the problem. Just as you use expressions to show 
calculations on a form, you can also use expressions to set rules for validating data.

To create the rule, set the ValidationRule property of the StartDate control to the 
following expression:

<#8/1/94# Or >#8/31/94#

The Date format you use in the expression is determined by the setting in the 
International section of the Windows Control Panel for each country. In the 
preceding expression, the dates appear in the format for the United States. In the 
United Kingdom, you would use 1/8/94 and 31/8/94; in Sweden, you would use 
8-1-94 and 8-31-94.

Set the ValidationText property to a message that you want Microsoft Access to 
display if the date entered in the text box falls within the defined range:

That trade show conflicts with the company planning retreat.

If you enter an invalid date, Microsoft Access won’t accept it. Instead, it displays 
your message so that you can correct the error.

You can also set a validation rule for a field when you design your table. Then 
Microsoft Access will apply that validation rule automatically to any control you 
create that’s bound to the field. If necessary, you can set a separate, more restrictive 
validation rule for that control on the form.

More Information For more information about creating expressions, see Chapter 
18, “Using Expressions in Forms,” in the Microsoft Access User's Guide. For 
more information about setting default values and validation rules for fields in 
tables, see Chapter 8, “Changing and Customizing Tables,” also in the Microsoft 
Access User's Guide.

When you finish working with the Trade Shows form, save it and then close it.
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What’s Next?
Now you know how to create two of the basic elements of a Microsoft Access 
database: tables and forms.

In Part 3, “Working with Data,” you’ll learn how to create and use the third basic 
element of a Microsoft Access database— queries. In addition, you’ll find out how 
to find and sort records and how to combine data from two tables into a single form.



In Part 3 of Microsoft Access Getting Started, you’ll learn how to find, 
combine, change, and work with your data.

■ Chapter 6, “Creating a Query,” shows you how to use a query to bring 
data from different tables together in the same datasheet.

■ Chapter 7, “Finding the Data You Want,” shows you how to find the data 
you want to see.

■ Chapter 8, “Showing Data from More Than One Table on a Form,” 
shows you how to combine data from different tables on a single form.

“I want to see supplier information along with product information in the 
same window. How do I show data from different tables in the same 
datasheet?”

“We have hundreds of customers, but I just work with the ones in my region. 
How do I limit the records I see?”

“I need a form that shows the product category on top and every product in 
that category below so I can scroll through the list and make changes. Is there 
a quick way to make that form?”
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Creating a Query
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In this chapter, you’ll learn how to create a query that brings related data from 
different tables together in the same datasheet.

Chapter Contents
Create a Query 
The Query Window 
Join Tables 
Select Fields 
Specify Criteria 
Specify Additional Criteria 
Sort Records 
Calculate Totals 
Modify a Query
Save a Query and Print a Dynaset 
W hat’s Next?

The Challenge It’s time to decide which category of products to use for your 
upcoming “product of the month” mailing. You’ve narrowed the choice down to 
two categories: confections and beverages. Your final decision is based on how 
many units you have in stock for each category.

The Approach To gather information for this decision, you’ll create a query that 
retrieves data from both the Categories table and the Products table.
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Create a Query
Before deciding between beverages and confections as your next featured category 
of products, you want to review how many units you have in stock for each 
category. You’d like to see the category names as well as the product names and 
units in stock. The information is in two tables: The Categories table contains 
category names; the Products table contains product names and units in stock.

Categories Table
C a te g o r y  ID

Data about 
products

C a te g o ry  N a m e
B e ve ra g e s  
C o n d im e n ts 
C o n fe c tio n s 
D airy Pro ducts

Description

Data about 
categories

S o ft d rinks, c o ffe e s, te a s , beer, a n d  ale 
S w e e t a n d  s a v o ry  s a u c e s , relishes, sp re a d s 
D e s s e rts , c a n d ie s , sw e e t breads 
C h e e s e s _________________________________

G Products Table
M P ro d u c t ID P ro d u c t N a m e U n its  In S to c k
Pi
o , 1 C h a i 39
Ol 2 C h a n g 1 7

3 A n is e e d  S y ru p 1 3
4 C h e f A n to n ’s C a ju n  S e a so n in g 53
5 C h e f A n to n ’s G u m b o  M ix 0
6 G r a n d m a ’s B o y s e n b e rry  S p re a d 1 2 0
7 U n c le  B o b ’s O r g a n ic  Dried P e a rs 1 5
8 N o rth w o o d s  C ra n b e rry  S a u c e 6

C a te g o r y  ID

To bring together the data you need from the two tables, you’ll create a select 
query. A select query retrieves a set of records that match the criteria you specify.

► To create a select query
1. Start Microsoft Access, and open the Northwind database (NWIND.MDB).

2. In the Database window, click the Query button.

r  Click here.

Table

, Quer»

Queries
■ m i

Category List 
Opl Category Sales for 1993 
gP  Customer List 
IP  Daily Order Totals

3. Choose the New button.

CM 
CM 

CM 
CM 

CM
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Microsoft Access displays the New Query dialog box.

Query Wizards New Query

Cancel I

4. Click the New Query button.

Microsoft Access opens a Query window and displays the Add Table dialog box 
so that you can select the tables to use for your query.

H

-View------------------------------
( I1 Tables C  Queries C Both

5. Select the Categories table, and then choose the Add button. 

Microsoft Access adds the Categories table to your query.

6. Select the Products table, and then choose the Add button. 

Microsoft Access adds the Products table to your query.

7. Choose the Close button.

Microsoft Access closes the Add Table dialog box.

Tip To add a table to your query after you close the Add Table dialog box, you can 
drag the table from the table list in the Database window and drop it in the upper 
portion of the Query window. Or choose the Add Table command from the Query 
menu, and select the table you want in the Add Table dialog box.

rMdf*!»le
able/Query:

ustomers 
mployees 
Irder Details 
Irders 
'roducts 
tappers 
uppliers 
rade Shows

Tables in the database.
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The Query Window
A query is a question you ask about the data in your database, such as, “Which 
customers placed orders last month?” or “How many products do we have in each 
category?” To create a query, you specify the fields and records you want to see in 
the Query window.

The Query window is a graphical query-by-example (QBE) tool. Because of its 
graphical features, you can use a mouse to select, drag, and otherwise manipulate 
objects in the window to define an example of the records you want to see.

You add tables to the query here.--------

Select Query; Query!
Categories

>

Categoiy ID
Category Name 
Description 
Picture_______

Products

Product ID
Supplier ID
Category ID
Product Name
English Name T

± n

Field:
Sort:

Show: D U 1 1
Criteria:

or:

♦I 1

You specify the fields and records you want--------
to include in the query in the QBE grid.

Note that the Categories and Products tables are joined by a line that connects the 
two Category ID fields. (To see the join line more clearly, drag the tables farther 
apart.) The join line tells Microsoft Access how the data in the two tables is related. 
Microsoft Access uses this information to associate products and categories 
correctly. Here’s how it works: Suppose you tell Microsoft Access that you want to 
see the category names from the Categories table and the product names and units 
in stock from the Products table. Microsoft Access uses the Category ID fields to 
connect the correct category information to each product.
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Microsoft Access uses the Category ID 
fields to match values in the two tables...

Categories Table Products Table
Category Name Cateqory ID- "Cateqory ID Product Name Units In Stock
Beverages 1 1 Chai 39
Condiments 2 2 Aniseed Syrup 13
Confections 3 2 Chef Anton's Cajun Seasoning 53

1 Chang 17/

...and show 
you the data 
in one query.

^ftti^ry’s Dynaset / z .
Category Name Product Name Units In Stock
Beverages Chai 39
Beverages Chang 17
Condiments Aniseed Syrup 13
Condiments Chef Anton's Cajun Seasoning 53

Microsoft Access can determine how to use the Category ID field to join the 
Categories and Products tables because the designer of the Northwind database 
created a relationship between the two tables at the time the tables were built. In 
that relationship, the designer specified that the two tables were related through 
their Category ID fields.

It’s a good idea to create relationships between your tables, because then Microsoft 
Access can join the tables in a query automatically in many cases. Even if you do 
not create relationships between tables, Microsoft Access will join them 
automatically when the tables are added to a query, as long as each table has a field 
with the same name and a compatible data type and one of those fields is a primary 
key.

Note In the Query window, Microsoft Access displays a table’s primary key field 
or fields in bold. Note in your query, for example, that the Category ID field in the 
Categories table is in bold, indicating that the Category ID field is the primary key 
of the Categories table. A primary key is indexed by Microsoft Access 
automatically, which helps speed up queries and other operations. For example, 
Microsoft Access can process a join in which one of the joined fields is indexed 
faster than it can process a join in which no indexed field is included. For that 
reason, it’s best to use primary key fields in joins.

More Information For more information about creating relationships between 
tables, see Chapter 7, “Table Basics,” in the Microsoft Access User's Guide. For 
tips on designing a relational database, see Chapter 2, “Designing a Database,” 
also in the Microsoft Access User's Guide.
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Join Tables
If Microsoft Access has not joined your tables automatically or if you haven’t 
created a relationship between the tables yourself, the tables won’t be connected by 
join lines in the Query window. You can still use related data from the two tables, 
however, by joining the tables in the Query window when you create the query.

Before you can join two tables in a query, the related fields must be present in both 
tables. For the join to work, the two fields must contain matching data in related 
records. For example, if you join the Category ID field from the Categories table to 
a field other than Category ID in the Products table, Microsoft Access won’t be 
able to relate records in the two tables because the joined fields won’t have 
matching data.

If you’d like to try joining tables now, delete the join line between the Categories 
and Products tables and then draw it again.

► To delete a join line

•  Click the join line to select it, and then press the d e l  key.

Microsoft Access deletes the join. This doesn’t change the data in your tables, 
but if you create a query now that includes fields from both tables, you might be 
surprised at the result. When it cannot determine how to associate the data, 
Microsoft Access creates a record for every possible combination of data 
between the tables.
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• Drag the Category ID field from the Categories table to the Category ID field in 
the Products table. (Select the field in the Categories table, and then hold down 
the mouse button while you move the mouse. When the pointer is over the 
Category ID field in the Products table, release the mouse button.)

-  Drag from here...

To draw a join line

Categories

Category Name 
Description 
Picture_________

Microsoft Access joins the tables.

When you draw a join line between two tables in the Query window, the join 
applies to that query only. If you use the same two tables in another query, you’ll 
need to join them again.

Note Join lines have properties you can set and change. To see the properties of a 
join line, double-click the line (or click the line and choose Join Properties from the 
View menu). For more information about join properties, press f i  from the Join 
Properties dialog box or see Chapter 11, “Designing Select Queries,” in the 
Microsoft Access User's Guide.

...to here. The pointer 
turns into a field symbol.
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Select Fields
Now that you have the tables you want for your query, you’re ready to define the 
records you want. Start by selecting the fields from each table that you want. For 
this example, you’ll select the Category Name field from the Categories table and 
the Product Name and Units In Stock fields from the Products table. The result of 
your query will look like the following illustration.

I T Select Query: Query2 B B I
1 Category Name 1 Product Name 1 Units In Stock 1Jh

T Condiments Louisiana Fiery Hot Pepper Sauce 76
Condiments Louisiana Hot Spiced Okra 4
Condiments Original Frankfurter grline Softe 32
Confections Pavlova 29

To add a field to a query, you drag it into a cell in the Field row of the QBE grid. 
First, you’ll add the Category Name field to your query.

► To add fields to a query
1. Drag the Category Name field from the Categories field list to the first cell in 

the Field row of the QBE grid.

r  Drag from here...

Select Query; Query2

ELI
Field:
Sort:

Show:

...to here.-1

Products
*
Product ID
Supplier ID
Category ID
Product Name
English Name

— QBE grid

2. When the pointer is over the cell, release the mouse button.

3. Use the same method to add the Product Name and Units In Stock fields from 
the Products field list.
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When you finish, the QBE grid contains three fields. The check boxes in the Show 
cells for those fields are checked, which means the data in the fields will be 
displayed in the query’s datasheet.

Categories

CategoiylD
Category Name 
Description 
Picture_______

♦nr

Products
-
Product ID
Supplier ID
Category ID
Product Name _
English Name ±1

*

Field:
Sort

Show
Criteria;

or;

Category Name

ZEE

ELC

□SE ~E3~ ~rr

Note Microsoft Access provides four methods that you can use to add a field to a 
query. You can drag the field from the field list to a cell in the QBE grid, as you did 
here. You can also type the field name in the cell. You can click the cell and select 
the field you want from its drop-down list. Or you can double-click the field you 
want to add in the field list. Use the method that’s easiest for you.

Now you can take a look at the records this query defines.

► To see the results of a query
• From the View menu, choose Datasheet (or click the Datasheet View button on 

the toolbar).

Microsoft Access displays the records you defined in your query.
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Specify Criteria
You define the query, which describes the set of records you want. The answer to a 
query— the updateable set of records that a query defines— is called a dynaset. 
When you use a query to access data, its dynaset consists of the current data from 
the tables where the data is stored. In a multiuser environment, you can see changes 
that others make to records in a dynaset right away. If you change data in a dynaset, 
Microsoft Access updates the data in the underlying tables.

You can use queries and dynasets in the same way you use tables to access data.
For example, you can base a form or report on a query that displays data from two 
or more tables. Because the data in the dynaset is always current, you know that the 
data you’re viewing on the form or report reflects the latest changes in your 
database. Any changes you make to the data using the form are saved.

Currently, your dynaset includes all the products in the Products table. But in this 
case, you’re only interested in seeing products in the beverages and confections 
categories. To tell Microsoft Access which records you want to see, you specify 
criteria. You use values in fields to pinpoint the records you want to see.

Select Query: Query2 '.......DDI
Category Name 1 Product Name 1 Units In Stock
Beverages Rhonbrau Klosterbier 125 1
Beverages Lakkalikdori 57
Confections Pavlova 29
Confections Teatime Chocolate Biscuits 25

You want to see 
records with 
Beverages or 
Confections in the 
Category Name field.

Microsoft Access uses the criteria to select the records you want to include in the 
dynaset— and no others.

► To specify criteria for a query
1. To return to Design view, choose Query Design from the View menu or click the 

Design View button on the toolbar.

2. In the lower portion of the Design window, move to the Criteria cell for the 
Category Name field.

3. Type Beverages in the cell, and then press e n t e r .

Field: Category Name Product Name
Sort:

Show: IKI IE!
Criteria: "Beverages"

or:

±u
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Note that Microsoft Access places quotation marks around Beverages after you 
press e n t e r .  If you type a text value that contains spaces or commas, Microsoft 
Access usually encloses that value in quotation marks as well. For example, if 
you type New York in a Criteria cell and press e n t e r ,  Microsoft Access 
displays “New York” in the cell.

To see your dynaset, choose Datasheet from the View menu or click the 
Datasheet View button on the toolbar.

- i » .D;' ; T Í *

Category Name I Product Name I Units In Stock 1♦
► Chai 39

Beverages Chang 17
Beverages Guaraná Fantástica 20
Beverages Sasquatch Ale 111
Beverages Steeleye Stout 20

Microsoft Access limits the dynaset to the records that match your criteria.

In My Case: Can I Update My Tables from a Query?
In most cases, you can update data in a query and have Microsoft Access 
save your changes to the table where the data is stored. For example, you can 
change any of the fields in the query you just created, even if your change 
affects many records in the dynaset. If you change “Beverages” to “Drinks” 
and then move to the next record, Microsoft Access will automatically 
change each “Beverages” category name to “Drinks.”

If your query calculates totals over many records, Microsoft Access doesn’t 
accept updates. For more information about when you can update data in a 
query, see “Designing Queries for Updating Records” in Chapter 11 in the 
Microsoft Access User's Guide.
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Specify Additional Criteria
By adding and combining criteria in the Query window, you can create powerful 
queries that meet a variety of exacting conditions.

When one field (or column) in your query has multiple criteria, Microsoft Access 
includes a record in your dynaset if it meets any one of the criteria. Multiple criteria 
for one field tells Microsoft Access, “Include the record if it has this value or that 
value in the field.”

On the other hand, when you have criteria for more than one field in the same 
Criteria row, Microsoft Access assumes that the record must meet all of the criteria 
before it can be included. Criteria for more than one field in the same Criteria row 
tells Microsoft Access, “Include the record if it has the specified values in this field 
and in that field.”

Field: Company Name Contact Title
Sort:

Show: IK] 1X1 i i
Criteria: <MM" "Owner"

or: <MM" "Sales Manager" |

* L J

In the preceding illustration, if the Company Name starts with a letter from A 
through L and the Contact Title is either Owner or Sales Manager, Microsoft 
Access includes the record in the dynaset.

By specifying additional criteria (you must repeat the <M criterion on both lines), 
you can create powerful queries that set multiple conditions for the data you want. 
For more examples and details about creating complex queries, see Chapter 11, 
“Designing Select Queries,” in the Microsoft Access User's Guide.

In the following procedure, you’ll add confections to the criteria for the Category 
Name field in your query.

To add criteria to a query
1. Switch your query to Design view. (Choose Query Design from the View menu 

or click the Design View button on the toolbar.)

2. In the Category Name column, type Confections in the cell below the cell that 
contains Beverages, and then press ENTER.

This tells Microsoft Access to include records that contain either Beverages OR 
Confections in the Category Name field.
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Field: Category Name Product Name Units In Stock
Sort:

Show: (XI IXI IX]
Criteria:

or:
"Beverages"
"Confections"

± U

To check your results
• From the View menu, choose Datasheet (or click the Datasheet View button). 

Now Microsoft Access includes both beverages and confections.

In My Case: What Kinds of Criteria Can I Specify?
To specify criteria, you enter a phrase or expression, in the Criteria cell for a 
field. Microsoft Access evaluates the expression and then looks in the field 
for values that match the result of the expression. Microsoft Access includes 
all the records with matching values in the field.

Here’s a list of common types of criteria that you can specify:

■ The value in a field is equal to the value you specify Just enter the 
value in the field’s Criteria cell. For example, to see all suppliers located 
in Canada, enter Canada in the Criteria cell for the Country field.

■ The value falls within a range of values Enter an expression that 
defines the range you want. For example, to see all products with more 
than 10 units in stock, enter >10 in the Units In Stock cell. To see 
products with 10 to 20 units in stock, enter Between 10 and 20

■ The value begins with the value you set Use the asterisk (*) 
wildcard. For example, to see all employees whose last name begins with 
M, enter M* in the Criteria cell for the Last Name field. Text fields in 
Microsoft Access are not case sensitive, so your dynaset will include all 
values that start with M or m.

■ The value is one in a list of values Use the In() function. For 
example, to see the records of all suppliers located in Sweden, Denmark, 
Norway, or Finland, type the following in the Criteria cell for the Region 
field: In(Sweden, Denmark, Norway, Finland)

More Information For more information about expressions in Microsoft Access, 
choose Search from the Help menu and search for “expressions: examples.”
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Sort Records
You have the set of records you want, but suppose you’d rather see them sorted by 
category name so that each category’s products are grouped together in alphabetic 
order. Then, suppose you also want products within a category sorted by how many 
units you have in stock so that you can see the products with the most units first.

p r DDI
Category Name 1 Product Name 1 Units In Stock 1
Beverages Steeleye Stout 20
Beverages Ipoh Coffee 17
Beverages Chang 17
Beverages Cote de Blaye 17
Beverages Outback Lager 15
Confections NuNuCa Nufi-Nougat-Creme 76
Confections Valkoinen suklaa 65
Confections Schoggi Schokolade 49
Confections Sir Rodney's Marmalade 40

Ascending order goes L  Descending order goes
from A-Z or 1 -100. from Z-A or 100-1.

Just as you can sort records in a table or form, you can sort records in a query by 
one or more fields. Microsoft Access uses the order of the fields specified in the 
query to determine the order in which to sort the fields.

► To sort records in ascending order

1. Switch to Design view.

2. Click the Sort cell for the Category Name field (or use the arrow keys to move 
to the Sort cell).

3. Select Ascending from the Sort list.

Field: Category Name
Sort: L £ -

Show: Ascending
Criteria: Descending

or: | |not sorted I |

♦ u

Click here to open the list.

4. Switch to Datasheet view to see the sorted records.

Microsoft Access sorts the records so that all the beverages come first and the 
confections follow. Now you’ll set the sort order for the Units In Stock field to 
see the products with the largest inventory first.
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► To sort records in descending order

1. Switch to Design view.

2. Set the sort order for the Units In Stock field to Descending (select Descending 
from the Sort list).

3. Switch to Datasheet view to see the sorted records.

Because the column for the Category Name field comes before the column for 
the Units In Stock field in your query’s Design view, Microsoft Access sorts the 
records first by Category Name and then by Units In Stock.

Field:
Sort:

Show:
Criteria:

Category Nam A
Ascending

W.
"Beverages"
"Confections"

ÏLl-

First field in 
the sort order

Product Name

i s :

Units In Stock!
Descending

a

Second field in 
the sort order

Category Name I Product Name
Beverages
Beverages
Beverages
Beverages

Rhonbrau Klosterbier 
Sasguatch Ale 
Chartreuse verte 
Lakkalikdori

125
111
69
57

When you sort by more than one field in a query, you can change the sort order 
of the fields by rearranging the columns in Design view. For details about 
moving columns in a query, see “Modify a Query” later in this chapter.

4. Return to Design view.

Tip A query that sorts data can be useful as the data source for a form or report or 
for a combo box or list box on a form.
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Calculate Totals
Often, the most interesting information you can see is a total, average, or some 
other type of tally over a set of records. For example, the average salary of all your 
managers can be more informative than a simple list of individual salaries.

Your query now shows the units in stock for each product in the beverages and 
confections categories. But, to decide which category to feature, you need to group 
the products in each category to see the total inventory you have in beverages and in 
confections.

0 I— r " ..........  - 1 -
Category Name I SumOfUnits In Stock I

► Beverages 559 
Confections 386

M H |R eccird :|l |of 2 I H M l

a
► To calculate totals in your query

1. From the View menu, choose Totals or click the Totals button on the toolbar. 

Microsoft Access displays the Total row in the QBE grid.

Field: Category Name Product Name Units In Stock . T
T otal: Group By Group By Group By
Sort: Ascendinq Descending

Show: x i IE! È
Criteria: "Beverages" _

or: "Confections" ♦
♦I I i ±

2 .

Note that Microsoft Access automatically fills in each box with “Group By.” 
Currently, the dynaset for this query displays the total units in stock for each 
product. But you want to see the total units in stock for each category. To group 
your records by Category Name, you need to delete the Product Name field from 
your query.

In the QBE grid, select the column for the Product Name field.

Field: 
T otal: 
Sort: 

Show: 
Criteria: 

or:

Category Name Product Name Units In Stock JK "
Group By Group By Group By
Ascending

f] ' '
Descending

*
"Beverages"
"Confections"

Ld I L±J

Click here to 
select the column.



Chapter 6 Creating a Q u e ry

Press the d e l  key (or choose Delete Column from the Edit menu). 

Microsoft Access deletes the field from the query.

In the Total cell for the Units In Stock field, select Sum.

Click here.

Field
Total
Sort

Show
Criteria

or

Category Name
Group By
Ascending

: a :
"Beverages"
"Confections"

Units In Stock

Sum
Avg
Min
Max
Count
StDev
Var

Microsoft Access displays the type of total you select in the cell.

To see the results, switch to Datasheet view.

Microsoft Access displays the total units in stock for each category.
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Modify a Query
The Query window is designed for flexibility and ease of use. Because of the 
window’s graphical features, you can easily move, insert, drag, and otherwise 
manipulate the fields and columns in your query.

► To move a column in a query

1. In Design view, click the field selector (column heading) of the column you want 
to move.

Field
Total
Sort

Show
Criteria

or

Category Name
Group By

Click here to 
select the column.

Ascending

"Beverages"
"Confections"

d _ L

2. Click the field selector again, hold down the mouse button, and drag the column 
to its new location.

► To insert a column in a query

1. Select the column to the right of where you want the new column inserted.

To insert a column here... - i r  ...select this column.

2. From the Edit menu, choose Insert Column. 

Microsoft Access inserts a blank column.

► To make a column wider or narrower

• Drag the right border of the field selector.

► To adjust a column’s width for the best fit

• Double-click the right border of the field selector.
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Microsoft Access adjusts the column width to accommodate the longest cell 
entry in the column.

When the pointer looks -| 
like this, you can drag 
the border.

Field: 
T otal: 
Sort: 

Show: 
Criteria: 

or:

Category Name
Group By
Ascending

"Beverages"
"Confections"

± □ 1

Or you can double-click 
here to adjust the column 
width for the best fit.

Units In Stock
Sum
Descending

1

You can also include a field in your query without having it appear in the datasheet. 
This is convenient if  you want to use the field to specify criteria for the dynaset but 
don’t want the field in your datasheet.

To exclude a field from the query’s datasheet
• Clear the fie ld ’s Show box by clicking it.

Field
Total
Sort

Show
Criteria

or

Category Name Units In Stock
Group By Sum
Ascending

X T  '
Descending

"Beverages"
"Confections"

tL L

Click here.
<100

Microsoft Access uses the criteria you’ve specified for the field to create the 
dynaset but doesn’t show the field in the datasheet.
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Save a Query and Print a Dynaset
Now that you have the results you want, you can save your query.

► To save a query
1. From the F ile  menu, choose Save (or click  the Save button on the toolbar).

2. Type Beverages or Confections in the Query Name box.

l 5  Save As 1
Query Name: 1 OK 1
|Beverages or Confections!

Cancel |

Choose O K .

M icrosoft Access saves your query in the database. Any modifications you have 
made to fields and columns are saved with the query so that your query w ill look 
the same the next time you open it.

You can print a dynaset just as you print records from a table.

► To print a dynaset
1. Open the query in Datasheet view, or select it in the Database window.

2. From the F ile  menu, choose Print (or c lick  the Print button on the toolbar). 

M icrosoft Access displays the Print dialog box.

3. Choose O K .

M icrosoft Access prints the dynaset.

More Information For more information about printing a dynaset, choose Search 
from the Help menu and search for “ printing.”
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In My Case: What Else Can I Do with Queries?
The query you created in this chapter is a select query, the most common
type. W ith M icrosoft Access, you can create other types o f queries:

■ Action  queries make changes to many records in just one operation. For 
example, suppose you want to raise all the salaries in one department by 
10 percent. Because the change affects all the records by the same 
percentage, you can have Microsoft Access do the calculations and make 
the updates for you. You  can also use an action query to make a new 
table, delete records from a table, or append records to a table.

■ Crosstab  queries present your data in a more compact format. W ith 
crosstab queries, you can summarize large amounts of information in an 
easy-to-read format.

■ Union queries combine matching fields from more than one table.

■ Pass-through  queries send commands to O D B C  servers such as 
M icrosoft S Q L  Server, Sybase SQ L  Server, or O R A C LE .

■ D ata-definition  queries use SQ L  statements to create, change, or delete 
tables and other objects in M icrosoft Access databases.

More Information For information about creating and using queries, see Chapter 
10, “ Query Basics,” in the M icrosoft A ccess User's G uide .
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What’s Next?
Y o u ’ve used the Query window to combine data from different tables, to specify 
criteria for the records you want to use, to sort records, and to display totals.

In the next chapter, you ’ ll learn more methods for finding the data you need to 
answer questions and make decisions.



Finding the Data You Want

In this chapter, you ’ll learn how to find a specific value in a set o f records. In 
addition, you’ l l learn how to use filters to interactively refine the set o f records 
you’re viewing.

Chapter Contents
Find a Value 

Sort Records 

Create a F ilter

Specify Criteria and App ly  a Filter 

W hat’ s Next?

The Challenge Sales o f Pavlova— Northwind Traders’ new tropical dessert from 
Australia— are good in Great Britain, but in North America they could be better. 
You plan a special mailing to promote this new product, but you need to determine 
which North American customers are most like ly to respond so that you can get the 
best results from your mailing.

The Approach First, you ’ ll find the record for a contact who can give you tips on 
new markets for Australian products. W ith that information, you can define the 
criteria to select customers who w ill receive your mailing.
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Find a Value
Suppose that you’re looking for the phone number o f a customer contact named 
Victoria. You want to call V ictoria because she can give you tips on finding new 
markets for Australian products, but you ’re not sure o f her last name or the 
company she works for. When you ’re looking for a specific value such as 
“ Victoria,” the Find command on the Edit menu o f a form or datasheet provides the 
quickest path to the record you want.

You can tell M icrosoft Access the exact value you want to find, or you can use 
these wildcard characters: the question mark (?), asterisk (*), or number sign (#). 
For example, you can use L?s to find Los, Las, or L6s; you can use L*s to find Los 
or Louis; or you can use A# X to find A 2 X  or A 9X .

To look for V ic to ria ’s record in the Customers table, you ’ ll use the Customers form 
in the Northwind Traders database because the customer’s name and telephone 
number are conveniently displayed on the form.

► To open a form
1. In the Database window, c lick the Form button.

r  Click here.

Table

Query

Forms

Report

M  Categories
I H  Categories Subform
I H  Country Filter Dialog
[ H  Customers
H I  Daily Order Totals
111 Employees

ID

Microsoft Access lists the forms in the Northwind database.

2. Double-click the Customers form.

M icrosoft Access opens the form and displays the first record.

► To find a value
1. Move to the Contact Name field. (You can c lick  the field, or press the t a b  key 

until the field is selected.)

2. From the Edit menu, choose Find (or click  the Find button on the toolbar). 

M icrosoft Access displays the Find dialog box.
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3. Type Victoria in the Find What box.

Find this value in the Contact Name field.

Customer >

ID: ALFKI I 

Nane: Alfreds Futteikiste

Maria Anders

I
{ Find What: Victoria

TM k  Sales Representative

Country

Where: | Match Whole Field
Search In- ----------

9  Current Field C  AH Fields

F  Match Case

"TTj Direction 

r  Up 

(• Down

I~ Search Fields as Formatted

Find First 

Find Next |

4. In the Where box, select Start O f Field.

Because the field contains both first and last names, you want M icrosoft Access 
to search for the value at the start o f the field.

5. Choose the Find First button.

M icrosoft Access moves to the first customer in the table with “ V ictoria” in the 
Contact Name field. (If the dialog box blocks your view of the form, you can 
move it out of the way by dragging its title bar.)

6. Choose the Find Next button.

M icrosoft Access doesn’t find another “ V ictoria” in the records that come after 
the current record. It asks i f  you want to continue the search from the beginning 
of the set of records.

7. Choose the No button.

Y o u ’ve already searched those records. Now you know that you have only one 
“V ic to ria” in your database.

8. Choose the Close button to close the Find dialog box.

Tip When M icrosoft Access is finding a value in a set o f records, it can search all 
fields in a ll records or just a particular field in all records. It takes M icrosoft Access 
longer to search all fields, so your search w ill go faster i f  you confine it to one 
field— especially if  the field is indexed. For more information about options in the 
Find dialog box, press fi from the dialog box. For information about indexing 
fields, choose Search from the Help menu and search for “ index.”
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Sort Records
Victoria reports that many new Australian immigrants reside in Seattle and Portland 
in the United States and in Vancouver, Canada. Rather than trying to go through the 
entire Customers table record by record to look for those residents, you can group 
records quickly by sorting the records. In this case, you’ ll group the records of 
customers in these three cities by sorting the C ity field in ascending order.

To sort records
1. To see more records in the window, switch to Datasheet view. (From the V iew  

menu, choose Datasheet, or c lick  the Datasheet V iew  button on the toolbar.)

2. In the datasheet, select the C ity column (or c lick  any field in the column).

Contact Name: Title: Address:
Maria Anders 
Ana T rujillo 
Antonio Moreno 
Thomas Hardy 
Christina Berglund 
Hanna Moos 
Frederique Citeaux 
Martin Sommer 
Laurence Lebihan 
Elizabeth Lincoln 
Victoria Ashworth 
Patricio Simpson 
Francisco Chang 
Yang Wang 
Pedro Afonso 
Elizabeth Brown 
Sven Ottlieb 
Janine Labrune 
Ann Devon 
Roland Mendel 
Aria Cruz 
Diego Roel

Sales Representati-
Owner
Owner
Sales Representati1 
Order Administrator 
Sales Fiepresentati' 
Marketing Managei 
Owner 
Owner
Accounting Manag 
Sales Representati- 
Sales Agent 
Marketing Managei 
Owner
Sales Associate 
Sales Representati' 
Order Administrator 
Owner 
Sales Agent 
Sales Manager 
Marketing Assistani 
Accounting M anag

Obere Str. 57 
Avda. de la Constiti 
Mataderos 2312 
120 Hanover Sq. 
Berguvsvagen 8 
Forsterstr. 57 
24, place Kleber 
C /  AraquiL G7 
12, rue des Bouche 
23 Tsawassen Blvc 
Fauntleroy Circus 
Cerrito 333 
Sierras de Granada 
Hauptstr. 29 
Av. dos Lusiadas,! 
Berkeley Gardens 
Walserweg 21 
67, rue des Cinquai 
35 King George 
Kirchgasse 6 | 
RuaOros, 92 
C/Moralzarzal, 86

City:
Berlin
México D .F
México D.F.
London
Luleä
M annheirn
Strasbourg
Madrid
Marseille
Tsawassen
London
Buenos Aires
México D.F.
Bern
oäo Paulo
London
Aachen
Nantes
London

Region:
EE

BC

SF

SP
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C lick  the Sort Ascending button on the toolbar. 

M icrosoft Access sorts the records. 

Scroll through the records to display the records with “ Portland” in the C ity  
field.

You can sort records to group them together quickly. — 1

Fran Wilson 
Liz Nixon 
Maurizio Moroni 
Paul Henriot 
Paula Parente 
Mario Pontes 
Bernardo Batista 
Janete Limeira 
Georg Pipps 
Carlos Hernández 
Jaime Yorres 
Pedro Afonso 
Aria Cruz 
Lúcia Carvalho 
Anabela Domingue 
Karl Jablonski 
José Pedro Freyre 
Jonas Bergulfsen 
Frédérique Citeaux 
Rita Müller 
Paolo Accorti 
Annette Roulet

Sales Manager 
Marketing Managei 
Sales Associate 
Accounting Manag 
Sales Manager 
Accounting Manag 
Accounting Manag 
Assistant Sales Age 
Sales Manager 
Sales Representati' 
Owner
Sales Associate 
Marketing Assistani 
Marketing Assistani 
Sales Representati1 
Owner
Sales Manager 
Owner
Marketing Managei 
Sales Representati' 
Sales Representati' 
Sales Manager

89 Chiaroscuro Rd. 
89 Jefferson Way 
Strada Provinciale ' 
59 rue de lAbbaye 
Rua do Mercado, 1 
Rua do Paço, 67 
Rua da Panificador 
Av. Copacabana, 2 
Geislweg 14 
Carrera 22 con Ave 
87 Polk St.
Av. dos Lusiadas, : 
Rua Oros, 92 
Alameda dos Canài 
A v. Inès de Castro, 
305-14th Ave. S. 
U  Romero, 33 
Erling Skakkes gat« 
24, place Kléber 
Adenauerallee 900 
Via Monte Bianco  ̂
1 rue Alsace-Lorrair

Portland 
Portland , ' 
Reggio Emilia 
Reims 
Resende 
Rio de Janeiro 
Rio de Janeiro 
Rio de Janeiro 
Salzburg 
San Cristobal 
San Francisco 
Sao Paulo 
Sao Paulo 
Sao Paulo 
Sao Paulo 
Seattle 
Sevilla 
S tavern 
Strasbourg 
Stuttgart 
T orino 
T oulouse

SP
RJ
RJ
RJ

T áchira
CA
SP
SP
SP
SP
W A

H
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Create a Filter
It’ s helpful to see records grouped by city, but it would be even more convenient to 
see only the records for those cities that you need. By  creating a filter, you can have 
M icrosoft Access select from the table only the customers in Portland, Seattle, and 
Vancouver.

City:
San Francisco
Vancouver
Walla Walla
Seattle
Austin
Buffalo
Portland
Helena
Seattle
Phoenix

Filtered Results

Vancouver

Seattle

Portland

Seattle

When you create a filter, you give M icrosoft Access a set o f criteria that describe 
the records you want to see. M icrosoft Access uses these criteria to select the 
records you want from the table or dynaset on which the form is based. (If you want 
to see all o f the records in the table or dynaset again, you can choose the Show A l l  
Records command from the Records menu or c lick  the Show A l l  Records button on 
the toolbar.)

First, you create the filter; then you apply the filter to your current set o f records.

Tip You can create a filter while you ’re using a table or a form. If you ’re using a 
query, specify criteria until you get the dynaset you want.

► To create a filter
• From the Records menu, choose Edit Filter/Sort (or c lick  the Edit Filter/Sort 

button on the toolbar).

M icrosoft Access opens the Filter window, where you define the records you 
want to see.
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—  Define the records you want here.

Filter: CustomersFilterl _____________ p o ll

3 D —

Field:
Sort:

Criteria:
or:

As you can see, the Filter window looks a lot like a Query window. In the F ilter 
window, however, you can’t add tables or compute values the way you can with a 
query; you can only specify criteria and sort order.

In My Case: Do I Want to Use Find or a Filter?
In some cases, it ’ s more efficient to use the Find command to get to the 
information you want. In other cases, i t ’ s better to use a filter. To decide 
which method w ill work better in your case, ask these questions:

■ Are you looking for one record that contains a particular value? If so, it ’ s 
probably more efficient to use the Find command.

■ Are you looking for a set of records that meets certain criteria? In that 
case, use a filter. W ith a filter, you can continue to refine your set o f 
records, asking new questions and getting different answers. In addition, 
you can use a filter to specify different criteria for different fields.

City
Ascending

< 4 _ l !♦

Customers
*
Customer ID
Company Nam<
Contact Name
Contact Title
Address ♦
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Specify Criteria and Apply a Filter
When you specify criteria in a filter, you use values in fields to pinpoint the records 
you want to see, as you do in a query. In this case, you want to see records in which 
the value in the C ity field is Seattle, Portland, or Vancouver. The In operator 
provides a convenient way to view records in which a fie ld contains one of a list o f 
values.

You created the filter immediately after sorting the C ity  field in the Customers 
table, so that field is already in the grid in the F ilter window. You  need only specify 
the criteria you want for the field.

► To specify the criteria for the City field
• Type In(Seattle, Portland, Vancouver) in the Criteria cell for the C ity  field, 

and then press e n t e r .

Field:
Sort:

Criteria:

City
Ascending
I n ("S eattle' 7  'Portland' 7  V  ancou ver'

Note that M icrosoft Access puts quotation marks around the values in the list after 
y o u  p re ss  E N TER .

Now you can apply the filter and see your results.

► To apply a filter
• From the Records menu, choose App ly Filter/Sort or c lick  the App ly  Filter/Sort 

button on the toolbar.

M icrosoft Access searches for customers located in Seattle, Portland, or 
Vancouver and displays these records in the Customers form. This is the set o f 
records you need for the special mailing.

The Big Cheese Liz Nixon 
Lonesome Pine Re Fran Wilson 
White Clover Mark« Karl Jablonski 
Laughing Bacchus Yoshi Tannamuri

Marketing Managei 89 Jefferson Way Portland 
Sales Manager 89 Chiaroscuro Rd. Portland 
Owner 305 - 14th Ave. S. Seattle
Marketing Assistani 1900 Oak St. Vancouver
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Tip To add a field to a filter, drag the field from the field list in the upper portion o f 
the Filter window to the grid in the lower portion of the window. M icrosoft Access 
adds the field to the filter.

Filters are great for quick, ad hoc searches because you can continue to adjust and 
refine your filter while you view the results. A  filter can be as simple as the one you 
just created, searching for all the records that contain a set o f values in one field, or 
it can be quite complex, searching for records that fall within a range o f values or 
combine criteria from more than one field.

More Information For more details on the kinds of criteria you can specify, see 
“ Specify Additional Criteria” in Chapter 6, “Creating a Query.”

In My Case: What’s the Best View of My Data?
Microsoft Access provides many options for viewing data. For a quick, 
convenient look at all the records in a table, you can just open the table from 
the Database window. Or, if  your table has hundreds of records and you 
want to view only a subset o f them, you can filter the table.

Sometimes, however, you ’ ll find a form or a query to be a more powerful 
tool for viewing records. W ith a form, you can arrange fields to see more of 
them at one time (though you may see fewer records at once). W ith a form or 
a query, you can look at just a subset of records. But perhaps the most 
powerful advantage of forms and queries is that you can use them to show 
related data from different tables together at the same time. In Chapter 6, 
“ Creating a Query,” you created a query that included data from two tables.
In Chapter 8, “ Showing Data from More Than One Table on a Form ,” you’ ll 
see how to combine data from different tables on one form.
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What’s Next?
Now that you ’re using M icrosoft Access to get some answers, it ’ s time to broaden 
your horizons. Suppose you want to group data from different tables on a form— to 
show all the orders placed by one customer under the customer’ s name, for 
example, or all the products grouped under one category.

In the next chapter, you’ l l create a subform that groups records from one table that 
correspond to a particular record from another table. Y ou ’ ll learn other methods, as 
well, for showing data from more than one table on a form.
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Showing Data from More Than 
One Table on a Form

129

In this chapter, you ’ ll learn how to create a subform that shows the set o f records 
associated with a single record on the main form. Y o u ’ ll also leam how to combine 
data from different tables into a single form by basing the form on a query.

Chapter Contents
Create a Form That Contains a Subform

Use a Query to Include Fields from More Than One Table

W hat’ s Next?

The Challenge Suppose you’re looking for a more convenient way to review the 
status o f your inventory. What you’d like is a form that displays a category o f 
products at the top and then lists all the products in that category below. Y ou ’d use 
the form to review your inventory and to update the Products table when your 
inventory changes.

The Approach Using a Form Wizard, you’ ll create a form that displays a group 
of records from the Products table for each category in the Categories table. Your 
form w ill be based on the Categories table, and it w ill contain a subform that’ s 
based on the Products table.
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Create a Form That Contains a Subform
When you work with data, it ’ s often convenient to see records combined in 
meaningful groups. For example, you might want to see all the products in each 
category grouped under the category name. To do that, you create a form that 
contains a subform. A  subform can display a set o f records that is associated with 
the record on the main form.

r Main form

Inventory Form

Inventory Form
Categoqp Name: ¡Beverages |

Description: Soft drinks, coffees, teas, beer, and ale

Product Name: I Unit Price: I Units In Stock: I Units On Order: ♦
► Chai $18.00 39 0

Chang $19.00 17 40
Guarana Fantésticc $4.50 20 0
Sasquatch Ale $14.00 111 0 ■

t lf i i l f L on n ▼
I Record: 1

H |< |R e c o rd :|1
| of 12 E E L

TEETTof 8

The subform shows more than one product for each category.

The inventory form that you build in this chapter is actually two forms in one. The 
main form  displays one record for one category o f products. A t the same time, the 
subform displays many records— all the products for the category displayed on the 
main form. This type of data is said to have a “ one-to-many” relationship— one 
category has many products.

A  form with a subform has advantages over a query for viewing this type of data. 
Because a query displays its result in a datasheet, each fie ld on the “ one” side of the 
relationship must be repeated for each record on the “many” side. But a form with a 
subform can show the data on the “one” side of the one-to-many relationship once 
at the top of the form and show all the records on the “many” side o f the 
relationship grouped below it.
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► To create a form that contains a subform
1. In the Database window, click the Form button.

2. Choose the New button.

M icrosoft Access displays the New Form dialog box.

3. Select the Categories table from the list of tables and queries.

Base the form on the table or query that contains the data you want to appear on 
the main form — the data on the “one” side o f the one-to-many relationship. In 
this case, you’ ll show category information on the main form and group product 
information on the subform.

4. C lick  the Form Wizards button.

M icrosoft Access displays the first Form W izard dialog box.

5. Make these choices as you go through the Form Wizard dialog boxes:

■ Select the Main/Subform Form Wizard, and choose O K .

■ Select the Products table as the source for the subform.

■ For the main form, add the Category Name and Description fields.

■ For the subform, add the Product Name, Unit Price, Units In Stock, and 
Units On Order fields.

■ Select any style for your form.

■ G ive your form the title Inventory Form.
■ Choose the Finish button.

■ Save the subform, and name it Inventory Subform.
The Form W izard creates your form and opens it for you. Scroll through the 
records to see how the form works. For each record in the Categories table, the 
subform displays the corresponding products from the Products table. If 
necessary, scroll through the subform to see all o f its records.

When you finish looking at the form, close it. You won’t use this form again in 
Microsoft Access Getting Started, so you don’t need to save it.

M icrosoft Access knows which products to group under which categories in your 
form because a relationship has been defined in the database between the 
Categories and Products tables. For more information about creating relationships 
between tables, see Chapter 3, “Creating a Table.”



132 Part 3 Working with Data

Use a Query to Include Fields from More Than 
One Table

Suppose that you want to review your products one by one to decide which products 
to reorder. Y o u ’d like to use a form rather than a datasheet because a form has a 
more convenient layout for viewing individual records. A lso, it would be convenient 
to have the supplier’ s name and phone number appear on the form along with the 
product name.

Inventory Review
Product Name: |Chai 

Unit Price:

Units In Stock:

Units On Order: 

Company Name: 

Phone:

Product
information

Supplier
information

In this case, you don’t need to group the data from either table. You just need to 
combine data from different tables in the same record on a form. To do that, you 
create a query that includes the fields you want and then base the form on the query.

► To create a query
1. From the Database window, create a new query (click the Query button, choose 

the New button, and then choose the New Query button in the New Query 
dialog box).

2. Add the Products table and the Suppliers table to the query, and then close the 
Add Table dialog box.

M icrosoft Access displays the Query window, showing the tables you added. 
Note that the two tables are connected with a jo in line.

3. From the tables, drag the follow ing fields to the Field row of the Q B E  grid:

■ From the Products table: Product Name, Unit Price, Units In Stock, and 
Units On Order

■ From the Suppliers table: Company Name and Phone

4. Save the query, and name it Products and Supplier Phone Numbers.
5. Close the query.
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More Information For detailed steps on creating a query, see Chapter 6, “Creating a 
Query.”

To base a form on a query
1. In the Database window, select the Products and Supplier Phone Numbers query 

you just created.

2. C lick  the AutoForm button on the toolbar.

M icrosoft Access creates a form based on the query. AutoForm includes a ll the 
fields in the query on the form. Now you have a form that shows data from both 
the Suppliers and the Products tables in the same record. For each record in the 
Products table, the form displays the corresponding values from the Supplier 
table. Scroll through the records to see how the form works.

When you finish looking at the form, close it. You won’t use this form again in 
M icrosoft Access Getting Started, so you don’t need to save it.

In My Case: When Would I Want to Base a Form or Report on a 
Query?
You can base any kind of form or report on a query. Queries are a 
convenient way to see fields from more than one table in the same record. 
For example, suppose that you want a form or report that lists each sale your 
company made during a month. You want to show the order number, the 
name of the customer who placed the order, the name of the employee who 
took the order, and the amount of the order— all on one record. The easiest 
approach is to create a query that includes the fields you want from the 
Customers, Employees, and Orders tables. Then base your form or report on 
the query. When the W izard prompts you to select fields to include on the 
form or report, you w ill have all the fields in the query to choose from. 
Because the data in a dynaset is always current, you know that the data 
displayed in your form or printed in your report is completely up to date.
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What’s Next?
Congratulations! In Part 3, you learned how to find the data you want and how to 
combine data from different tables in a single query or form.

In Part 4, “ Presenting Your Data,” you ’ ll learn how to create reports and mailing 
labels. Y o u ’ ll also learn how to use the Command Button W izard to add a button to 
a form.



P A R T  4

Presenting Your Dais

Part 4 of M icrosoft Access Getting Started shows you how to create 
professional reports, print mailing labels, and make your forms work 
together.

■ Chapter 9, “ Creating Reports and M ailing  Labels,” explains how to group 
data on reports with subtotals and totals. You also learn how to use 
M icrosoft Access to create and print mailing labels.

■ Chapter 10, “Customizing and Automating,” shows you how to add a 
button to a form that you can use to open another form.

“M y  report is for the directors, so it has to look great. How do I pull it all 
together?”

“ I print mailing labels on three sizes o f labels. Can M icrosoft Access help me 
do that?”

“ I want to be able to press a button on my order form to see detailed 
information about a product that’ s been ordered. How do I mae that button 
work?”
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Creating Reports and Mailing 
Labels

137

In this chapter, you ’ ll learn how to create a report that groups data and shows totals 
across groups. Y o u ’ ll also learn how to create and print mailing labels.

Chapter Contents
How to Use Reports to Present Data 

Create a Report with Grouped Data 

Preview, Print, and Save a Report 

A  Report in Design V iew  

Create and Print M a iling  Labels 

W hat’s Next?

The Challenge Before the Northwind Traders annual meeting, you plan to m ail a 
sales report to the sales staff. The report should include an overview of category 
sales as well as details about each product’ s sales.

The Approach First, you ’ ll create a report that effectively organizes and presents 
the sales data. Then you’ ll create mailing labels to mail invitations to employees for 
the annual company meeting.
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How to Use Reports to Present Data
You can use a report to present your data in print. W ith a report, you have greater 
flex ib ility to present summary information than with a form. For instance, you can 
include totals across an entire set o f records in a report. A  report is much like a 
form, except that it gives you greater control over how data appears in print.

-  Use a report to show groups of data with subtotals and grand totals.

Sales for 1993
2 5 -Aug-93

Category Name Product Name Product Sales

Beverages
Chai $6,629.4
Chang $7,401.45
Chartreuse verte $6,869.70
Côte de Blaye $6.3463.97
Guaraná Fantástica $1,785.37
Ipoh Coffee $12,817.90
Lakkalikôori $8.149.68
Laughing Lumberjack Lager $1.120.00
Outback Lager $6.754.50
Rhônbrau Klosterbier $4.506.62
Sasquatch Ale $1,927.80
Steeleye Stout $5,762.70

$127,189.09
18.90%

Condiments
Aniseed Syrup $2,114.00
Chef Anton's Cajun Seasoning 
Chef Anton’s Gumbo Mix

$5.676.88
$1,014.12

Genen Shouyu $1,474.82
Grandma's Boysenberry Spread $3,837.50
Gula Malacca $6,490.89
Louisiana Fiery Hot Pepper Sauce $9,725.52
Louisiana Hot Spiced Okra $2,958.00
Northwoods Cranberry Sauce $5,060.00
Original Frankfurter griine SoBe $4.960.28
Sirop d erable $9.453.45
Vegie-spread $3.696.38

$56,461.84
8.39% j

Grand Total: $672,813.58

3

—  Reports can show grand totals across groups of records.
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You can use graphics and a variety of controls on a report, just as you can on a 
form. A l l  the methods you learned for creating forms in Part 2, “ Build ing a 
Database,” also work for creating reports.

One of the differences between forms and reports is how you group data. As you 
saw in Chapter 8, “Showing Data from More Than One Table on a Form ,” you 
group data on a form by creating a main form that contains a subform. The main 
form is based on a table or query, and the subform is based on a related table or 
query. In contrast, you can group data on a report from a single table or query. The 
table or query in Datasheet view and the report display the same set o f data, but 
each presents the data differently.

i-  The category name appears in every row in the datasheet.

Category Name I Product Name I Product Sales
Beverages
Beverages
Beverages
Beverages
Beverages
Beverages
Beverage
Beverage
Beverage
Beverage
Beverage
Beverage
Condimen
Condimer
Condimen
Condimen
Condimen

H | < |Recorc

Chai
Chang
Chartreuse verte 
Côte de Blaye 
Guaraná Fantástica 
Ipoh Coffee_______

$6 ,629.40 
$7,401.45 
$6,869.70 

$63,463.97 
$1,785 37 

$12,817 90

The records appear 
as one large group.

Sales for 1993
25-Aug-93

Category Name Product Name Product Sales

Beverages
Chai $6.629.4
Chang S7.401.45
Chartreuse vene S6.869.70
Cote de Blaye S6.3463.97
Guaraná Fantástica SI.785.37
Ipoh Coffee SI 2.817.90
Lakkalikoorí S8.149.68
Laughing Lumberjack Lager S I.120.00
Outback Lager S6.754.50
Rhónbrau Klosierbier S4.506.62
Sasquatch Ale SI.927.80
Steeleye Stout $5,762.70

$127,189.09
18.90%

Aniseed Syrup $2.114.00
Chef Anton's Cajun Seasoning $5,676.88
Chef Anton's Gumbo Mix $1.014.12
Genen Shouyu $1.474.82
Grandma's Boysenbeny Spread $3.837.50
Gula Malacca $6.490.89
Louisiana Fiery Hot Pepper Sauce S9.725.52
Louisiana Hot Spiced Okra $2.958.00
Nonhwoods Cranberry Sauce $5.060.00
Original Frankfurter griine SoBe $4.960.28
Sirop d'erable $9.453.45
Vegie-sprcad $3.696.38

$56,461.84
8-39%

The records for each 
category appear as 
separate groups.

The Sales for 1993 report has one group level that groups the data by category 
name. Y o u ’ ll create this report in this chapter.
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Create a Report with Grouped Data
The report you ’ ll create shows Northwind Traders sales for 1993. The Northwind 
Traders database already has a query named Sales for 1993 that brings together the 
data you want to present.

IT Select Query: Sales for 1993 D D l
1 Category Name I Product Name I Product Sales I

T Beverages Chai $6,629.40
Beverages Chang $7,401.45
Beverages Chartreuse verte $6,869.70
Beverages Côte de Blaye $63,463.97
Beverages Guaraná Fantástica $1,785.37
Beverages Ipoh Coffee $12,817.90
Beverages Lakkalikbdri $8,149.68
Beverages Laughing Lumberjack Lager $1,120.00
Beverages Outback Lager $6,754.50

_ Beverages Rhonbrau Klosterbier $4,506.62

Your report w ill group the product sales for each category under the category’s 
heading and show total sales at the end.

More Information The Sales for 1993 query summarizes product sales for 1993. 
This type o f query is often used as the basis o f a report or graph. For an explanation 
of how to build queries that summarize data, see Chapter 11, “Designing Select 
Queries,” in the M icrosoft Access User's Guide.

► To create a report with grouped data
1. In the Database window, c lick  the Report button.

r  Click here.

9  Category Sales Subreport
9 Customer Mailing Labels
9  Employee Sales by Country
9 Employee Sales by Country 2
9 E mployee S ales S ubreport
9 Freight Charges
9 Invoice

2. Choose the New button.

M icrosoft Access displays the New Report dialog box.

3. Select the Sales for 1993 query from the list o f tables and queries.

4. Choose the Report Wizards button.

M icrosoft Access displays the first Report W izard dialog box.
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5. Make these choices as you go through the dialog boxes:

■ Select the Groups/Totals W izard.

■ Add all the fields from the query to the report.

■ Group records by the Category Name field.

■ Group the Category Name field by selecting Normal (the default).

■ Sort records on the Product Name field. That way, your products w ill appear 
in alphabetic order in their respective categories.

■ Choose the Executive style for your report.

■ G ive your report the default title Sales for 1993.
■ Choose the Finish button.

M icrosoft Access creates the report and opens it in Print Preview. In the next 
section, you’ ll examine the report more closely in Print Preview and learn how 
to print the report.

In My Case: Which Should I Create—A Form or a Report?
Data is useful when it communicates— when it gets a message across. You 
can use either forms or reports to communicate your message, depending on 
how you’re presenting the data and how you want it arranged. Forms and 
reports each have their own advantages.

Advantages of forms You can use a form to view, edit, and print data.
Because o f their versatility, you might find that forms meet most of your 
needs.

Advantages of reports You can use a report to show the “ big picture” by 
grouping data and showing grand totals as well as subtotals. You can also 
insert a report into another report (you can’t insert a report into a form). You 
can control page layout more easily in a report and print your data with a 
polished design. However, you can’t use a report to edit data on the screen; 
for that you need a form.
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Preview, Print, and Save a Report
After the Report W izard creates your report, M icrosoft Access displays your report 
as it would appear in print.

Microsoft Access
File Edit View Format Window Help

I W B l ie g

¡PPES3 X L
React.

Sales for 1993
25-Aup»3

Category Name Product Name Product Sales

Bev enges

Chai $6,629.40

Chang $7,401.45

Chartreuse verte $6,869.70

~ [ÑÜM

You can zoom out on your report to see a whole page at once.

► To see a whole page of the report
1. In Print Preview, position the pointer over the report. The pointer changes to a 

magnifying glass.

a
2. C lick  the report.

M icrosoft Access displays a view o f the whole page. You can use this view to 
look at the report’ s layout before printing it.

3. To zoom back in and view the data, c lick  the report again.

► To scroll in one page of the report when it’s zoomed in
• Use the horizontal and vertical scroll bars.
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► To scroll through pages of the report
• Use the Page buttons at the bottom of the window.

[ N ¡ 7 ]  Page: [1

You can print a report from Print Preview, from Design view, or from the Database 
window. If your system is set up for printing, try printing your report now.

► To print a report
1. From the F ile  menu, choose Print (or c lick the Print button on the toolbar).

2. Change the print settings if  you need to, and then choose OK.

M icrosoft Access prints your report.

► To save a report
1. From the F ile menu, choose Save.

M icrosoft Access displays the Save As dialog box.

2. Type Sales for 1993 in the Report Name box.

3. Choose O K .

M icrosoft Access saves the report.

Tip If you want to use the report output in another application, such as a 
spreadsheet or word-processing application, choose the Output To command from 
the F ile  menu to save the report output in a file. (You can also output a table or 
query in Datasheet view or a form in Form view or Datasheet view to another file.) 
You can save a file  in M icrosoft Excel spreadsheet format (.XLS), rich-text format 
(.RTF), or M S -D O S  Text (.TXT) format.

When you finish previewing a report, you can close the Print Preview window.

► To close the Print Preview window
• C lick  the Close button on the toolbar.

More Information For more information about printing reports and other M icrosoft 
Access objects, choose Search from the Help menu and search for “printing/’
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A Report in Design View
You use Design view to modify the design o f your report. The Design view of a 
report is sim ilar to the Design view o f a form.

► To open a report in Design view
1. In the Database window, click  the Report button to display the list o f reports.

2. Select the Sales for 1993 report.

3. Choose the Design button.

M icrosoft Access displays the report in Design view.

M icrosoft Access divides a report into sections. In Design view, each section o f the 
report appears once.

F R eport Reportl BDl
¿"Report Header

Sales for 1993
»

1

1

=Now()
¿"Page Header

3 Jcategory Name Product Name Product Sales

¿"Category Name Header

® ̂ Category Name 1
¿"Detafl

Product Name Product Sales 1
¿"Category Name Fooler

Q
=Siun([Product S
=[Field 131/[Field

II ¿"Page Footer 1

R =Paze
II ¿"Report Footer I

I® ̂  Grand T otal : =Siuni [Product sj
EU l±n

When you print the report, sections are repeated, as appropriate, until all the data in 
the report is printed. The controls in each section tell M icrosoft Access what data to 
print in the section. For example, the Category Name text box in the Category 
Name header (group header) is bound to the Category Name field in the Categories 
table. When you print the report, M icrosoft Access prints the first category’ s name 
in a text box in a group header. The group header is followed by the products for 
that group in the detail section and the totals for the group in the group footer. Then 
M icrosoft Access repeats the group header for the second category o f products, and 
so on, until all the categories are printed.
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The group header prints at the beginning of each group.

Sales for 1993
25-Aug-93

Category Name Product Name

Beverages

Condiments

Product Sales

Chai
Chang
Chartreuse verte 
Côte de Blaye 
Guaraná Fantástica 
Ipoh Coffee 
Lakkalikôôri
Laughing Lumberjack Lager 
Outback Lager 
Rhonbrau Klosterbier 
Sasquatch Ale 
Steeleye Stout

$6,629.4
$7,401.45
$6,869.70

$6.3463.97
$1.785.37

$12.817.90
$8.149.68
$1.120.00
$6.754.50
$4.506.62
$1.927.80
$5,762.70

$127,189.09
18.90%

Aniseed Syrup
Chef Anton’s Cajun Seasoning 
Chef Anton’s Gumbo Mix 
Genen Shouyu
Grandma's Boysenberry Spread 
Gula Malacca
Louisiana Fiery Hot Pepper Sauce 
Louisiana Hot Spiced Okra 
Northwoods Cranberry Sauce 
Original Frankfurter griine SoBe 
Sirop d'érable 
Vegie-spread

$2,114.00
$5,676.88
$1,014.12
$1,474.82
$3,837.50
$6,490.89
$9,725.52
$2,958.00
$5.060.00
$4.960.28
$9.453.45
$3,696.38

$56,461.84
8.39%

The report header 
prints at the 
beginning of 
the report.

The page header 
prints on every page.

The detail section 
prints for each record 
in the group.

The group footer 
prints at the end 
of each group.

The page footer 
prints on 
every page.

Note Not all reports have all the sections that this report includes. To add page or 
report headers and footers to a report, choose the Page Header/Footer or Report 
Header/Footer command from the Format menu. To add a group header and footer, 
choose Sorting And Grouping from the V iew  menu. For more information about 
creating and modifying sections in reports, see Part 5, “ Reports,” in the Microsoft 
Access User's Guide.
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Create and Print Mailing Labels
A  report designed to print names and addresses on standard mailing labels is a 
common part o f most database applications. The only problem is, there’s no true 
standard mailing label.

Many labels are designed for sprocket-feed printers, while others are designed in 
separate sheets for use with laser printers. Different countries have different 
standard sizes for labels. Some labels come in single columns; others come in two, 
three, or four columns. The M ailing  Labels Report W izard includes choices to 
match most common labels.

Y o u ’ l l create mailing labels to mail the invitations for the annual company meeting.

► To create mailing labels
1. In the Database window, create a report. (C lick  the Report button, and then 

choose the New button.)

M icrosoft Access displays the New Report dialog box.

2. Select the Employees table from the list o f tables and queries.

3. Choose the Report W izards button.
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4. Make these choices as you go through the dialog boxes:

■ Select the M a iling  Label Report Wizard.

■ When the Report W izard asks what you want on your mailing label, make 
the follow ing choices (use the buttons below the field list to add spaces and 
punctuation to your label and to start each new line):

■ First Name, a space, and Last Name for the first line

■ Address for the second line

■ City, Region, and Postal Code for the third line, providing punctuation 
and spaces as appropriate

■ Country for the fourth line

■ When the Report W izard prompts you for the fields you want to sort by, 
select the Last Name field.

■ Select whatever label type and dimensions you want.

■ Select the font, size, weight, and color you want for the label text.

5. Choose the Finish button.

That’ s all there is to it— M icrosoft Access creates your mailing labels.

To print mailing labels
• C lick  the Print button on the toolbar (or choose Print from the F ile  menu), and 

then choose O K  in the Print dialog box.

When you finish printing the labels, close your report. You won’t use this report 
again in M icrosoft Access Getting Started, so you don’t need to save it.

More Information For more information about printing mailing labels, choose 
Search from the Help menu and search for “mailing labels.”
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What’s Next?
Now that you ’ve learned how to present your data to its best advantage, it ’ s time to 
find out how to automate some of your most common tasks and get M icrosoft 
Access to do the work for you.

In Chapter 10, “ Customizing and Automating,” you ’ ll learn how to add a button to 
a form that opens another form.



Customizing and Automating

In this chapter, you’ ll learn how to use the Command Button W izard to add a button 
to a form that opens another form.

Chapter Contents
Create a Command Button That Opens a Form 

W hat’ s Next?

The Challenge For the annual company meeting, you’ ll distribute a letter of 
congratulations to each sales representative. You plan to review sales records for 
each employee so you can write a personal note on each letter. If you could 
automate the process of looking up the sales records, your job would go much 
faster.

The Approach You have a Sales Reps form that you use to look up employee 
names and addresses. Y o u ’ ll add a command button to the form so you can open a 
second form to display the employee’ s sales record.
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Create a Command Button That Opens a Form
You probably have certain tasks that you do repeatedly. For example, you might 
produce a monthly report o f sales totals. You  probably print the same basic report 
each month, replacing old totals with new ones. Using M icrosoft Access, you can 
automate tasks like these by creating command buttons with the Command Button 
W izard.

A  command button is a control on a form. Unlike most other controls, a command 
button does not display or accept data. Instead, when you press the button, it carries 
out an action. The Command Button W izard can create command buttons that carry 
out a wide variety o f actions, such as printing reports or opening forms.

Here’ s a common situation in which a command button can save both time and 
keystrokes. Suppose you use a Sales Reps form to look up the names and addresses 
o f your sales staff.

To see an employee’s sales record, you open the Sales Totals form and create a 
filter to see only the records for that employee.
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Use the Command Button Wizard to Create the Button
If you often use these two forms together, you can create a command button on the 
Sales Reps form that opens the Sales Totals form automatically.

► To create a button that opens a form
1. Open the Sales Reps form in Design view.

2. From the V iew  menu, choose Control W izards (if the Control W izards 
command does not display a check mark). Or click  the Control W izards tool in 
the toolbox so that the tool appears sunken.

3. C lick  the Command Button tool in the toolbox.

4. C lick  an empty area in the Sales Reps form. For example, c lick  the area to the 
right o f the Address field.

M icrosoft Access displays the first Command Button W izard dialog box.

5. Make these choices as you go through the dialog boxes:

■ Under Categories, select Form Operations.

■ Under When button is pressed, select Open Form.

■ Select Sales Totals as the form to open.

■ Choose to open the form and find specific data on it.

■ Select Employee ID as the control on the Sales Reps form to associate with 
the Employee ID field on the Sales Totals form.

■ Select Text and give the button the caption Sales Totals.
■ Choose the Finish button to create your command button.

M icrosoft Access creates the command button and places it on the Sales Reps 
form.

. It ■. I. ■. I... I... b.. I. I. I. ■. I... 13■. I. ■. I... I... 14.. I... I.

=[First Name] & " " & [Last Name]

[Title: ] Title

[Street:. Address
Sales Totals

I [E -p . f t  îployeej 

J Howe Phone: Hom ^ hon^ ^ J

Displays the Sales 
Totals form
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Test the Command Button
Test the button to see how it works.

► To test a command button
1. Switch the Sales Reps form to Form view.

2. C lick  the command button.

M icrosoft Access displays the sales totals for the first employee in the Sales 
Totals form.

Note The command button created by the Command Button W izard filters the 
Sales Totals form so that the form displays only those records that are associated 
with the current record in the Sales Reps form. To display the sales total for a 
different sales representative, close the Sales Totals form, move to the record you 
want in the Sales Reps form, and then c lick  the Sales Totals button again.
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In My Case: Should I Use the Command Button Wizard or Write a 
Macro?
The Command Button W izard can create command buttons for many actions 
you’ ll want M icrosoft Access to perform. The Command Button W izard 
defines a button’s action by creating an event procedure in Access Basic. If 
you want to change a command button’ s action, it’ s easiest to delete the 
button and use the Command Button W izard to create a new one with a 
different action.

If you want a button to perform an action that isn ’t offered by the Command 
Button Wizard, you can write a macro and then create a button to run that 
macro. For details about creating and running macros, see Part 6, “ Macros,” 
in the Microsoft Access User's Guide.

If you’re comfortable with programming, you can change a command 
button’ s action by changing its event procedure. For an introduction to 
creating and changing Access Basic procedures, see Microsoft Access 
Building Applications.
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What’s Next?
Congratulations. Now  you can use M icrosoft Access to organize, retrieve, and 
present your data. W hat’s next depends on what you want to do and how you want 
to do it.

To See

Delve farther into the Microsoft Access 
features you’ve learned so far

Find quick help while you’re working in 
Microsoft Access

Learn how to use Access Basic, the 
Microsoft Access programming language

Read details on any Microsoft Access 
property, action, function, or statement

Microsoft Access User's Guide

Help and Cue Cards

Microsoft Access Building Applications

Help
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Index

Special Characters
" (quotation marks) 

filter criteria 126 
query criteria 107

# (number sign) wildcard 120
* (asterisk)

record selector 52 
wildcard

finding values 120 
query criteria 109 

> (greater than) symbol 109 
? (question mark) wildcard 120 
3-D appearance 84-85 , 88

A
Access See Microsoft Access 
Access Basic

See also Macros 
Command Button Wizard 153 
defined 14
field names without spaces 47 
Microsoft Access Building Applications 34 
modules 14-15, 153 

Action queries 117 
Add Table command 99 
Add Table dialog box 99, 132 
Adding

See also  Creating 
controls 32, 86-87  
field descriptions 46 
fields to

filters 127
queries 104-105, 132 
tables 44 -47  

labels 82-83  
records in

forms 68-69  
tables 50-53  

tables to queries 99-100, 132 
Aggregate functions See Totals 
Alignment (label text) 84

Alphabetize See Sorting 
ALT+DOWN ARROW (open list) 49 
AND. combining criteria with 108 
Answer sets See Dynasets 
Appearances See Properties 
Applications

creating custom 34 
using reports in other applications 143 

Apply Filter/Sort button, Toolbar 126 
Apply Filter/Sort command (Records menu) 126 
Applying filters 126-127  
Ascending order, sorting records in 110 
Associating data See Relationships between tables 
Asterisk ( * )

record selector 52 
wildcard

finding values 120 
query criteria 109 

Attached labels 7 6 ,7 8 -8 1 ,8 8  
Attaching external tables 60 
Attributes See Data types; Properties 
Autoform Wizard 64-65  
Automatic data entry See Default values 
Automating tasks See Command buttons; Macros;

Modules; Wizards 
Averages 112-113 
Avg 113

B
Basic See Access Basic 
Bold

See also Properties 
label text 84 

Bold button, Toolbar 84 
Books. Microsoft Access 2 -3 , 34-35  
Borders (controls) 84 
Bound controls 86, 91 
Bound object frame tool 82-83  
BoundColumn property 91 
Break level See Grouping data 
Browse See Finding
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Btrieve 60
Bulk operations See Action queries 
Buttons, command 15, 82-83 , 150-153  
Buttons, Database window 

creating objects 30 
described 25 
Design 2 5 ,3 0 -3 1 ,7 4  
Form 25, 27, 30 
Macro 25 
Module 25 
New 25, 30 
object buttons 25, 30 
Open 25, 30 
Query 25, 26, 30, 98 
Report 25, 30, 140 
Table 25-26, 30, 42 

Buttons, macros attached to 14 
Buttons, navigation 

Form view 67
Page buttons (Print Preview) 143 

Buttons, toolbar See Toolbar

C
Calculated controls 92 
Calculations

See also Expressions; Functions; Totals 
Access Basic modules 13 
calculated controls 92 

Centered See Alignment (label text)
Charts See Graphs 
Check box tool 82-83  
Check boxes 66, 82-83  
Checking data See Validation rules 
Child forms See Subforms 
Close button. Toolbar 143 
Close command (File menu) 

forms 71 
tables 53, 59 

Close Database command (File menu) 27 
Closing

database 26-27  
forms 70-71
Print Preview window 143 
tables 52-53, 5 8 -5 9  
toolbox 82 

Color
controls 84-85  
property 31

Column width 
datasheet 56 
listboxes 90-91  
queries 114-115  

Column Width command (Format menu) 56 
ColumnCount property 90 
Columns

See also Fields 
datasheet

moving 56-57  
resizing 56 
viewing 26 

list boxes 8 6 -87 , 90-91  
queries

adding criteria 108-109  
calculating totals 112-113  
deleting 112-113  
inserting 114 
moving 114 
sorting records 111 
widening/narrowing 114-115  

tables
defined 9 -1 0  
viewing 26 

Column Widths property 90-91  
Combo box tool 82-83  
Combo boxes

See also List boxes 
Combo box tool 82-83  

Command Button tool 82-83 , 151 
Command Button Wizard 15 ,150-153  
Command buttons 15, 82-83 , 150-153  
Command line 20-21  
Commands See specific commands 
Computer requirements for Microsoft Access 18-19  
Condense spacing in mailing labels See Mailing labels 
Control Wizards button, Toolbox 82-83 , 86, 151 
Control Wizards command (View menu) 86, 151 
Control-menu box 59, 71 
Controls

See also specific controls 
adding 32, 86-87  
bound 86, 91 
calculated 92 
color 84-85
command buttons 15, 82-83 , 150-153  
Control Wizards button, Toolbox 82-83 , 86, 151 
defined 13, 76 
deleting 86
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Controls (continued) 
described 66 
labels See Labels 
moving 78-81  
properties 85, 88-93  
reports 144 
resizing 76 -77  
selecting 76 -7 7  
Toolbox described 82-83  
unbound 92 
validation rules 93 

ControlSource property 92 
Copying from another file See Importing data 
Count 113 
Counter 44, 50, 68 
Creating

See also Adding 
applications 34
command buttons 15 ,150-153
database 28
forms

described 3 0 -3 2 ,6 4 -6 5 , 133 
subforms 130-131, 139 

macros 15
mailing labels 146-147  
modules 15 
objects 30-32
queries 3 0 -3 2 ,9 8 -9 9 , 132-133  
reports 30-32 , 140-141 
tables 3 0 -3 2 ,4 2 -4 5  

Criteria
filters 124-127  
multiple 108-109  
queries 106-109  

Crosstab queries 117
CTRL+' (insert value of same field, previous record) 53
Cue Cards button, Toolbar 34
Cue Cards command (Help menu) 34
Cue Cards 34
Currency 4 4 -4 7 ,5 1
Current date 92
Current record 52
Cursor See Pointer

D
Data

See also  Values
associating See Relationships between tables 
entering See Data entry

Data (continued)
grouping See Grouping data 
importing 60-61  
properties See Properties 
querying See Queries 
types 4 4 -47 , 49 
validation rules 93 
viewing See Viewing data 

Data check See Validation rules 
Data entry

See also Forms 
automatic See Default values 
data types 44-45  
field properties 49 
validation rules 93 

Data types 44 -47 , 49 
Data-defmition queries 117 
Database management system (DBMS) 8 -9  
Database window

See also specific objects and views 
adding tables to queries 99 
buttons See Buttons, Database window 
closing databases 26-27  
creating objects 30-31  
described 23-25  
external tables 60 
importing tables 61 
printing tables 58 

Databases
closing 26-27  
creating 28 
DBMS 8 -9  
defined 8 -9  
naming 28-29  
objects See Objects 
opening

command line 20-21  
described 22-23  

RDBMS 8 -9  
relational 8 -9  
viewing 26-27  
window See Database window 

Datasheet command (View menu) 50, 67, 105, 109, 122 
Datasheet view 

See also Tables 
adding records 50 
moving columns 56-57  
Output To command 143 
query results 26, 105, 109 
reports vs. 139
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Datasheet view (continued) 
resizing

columns 56 
rows 56-57  

saving layout 57 
scrolling 26, 67 
sorting records 122-123  
switching to 12, 27, 50, 53, 67 
viewing data 2 6 -27 , 66 -6 7  

Datasheet View button, Toolbar 
query results 105, 109 
sorting records 122
switching to Datasheet view 27, 50, 54, 67 

Date function 92 
Dates

calculated controls 92 
datatype 44 
Date function 92 
Format property 3 1 ,4 8 -5 0 , 68 

dBASE
external tables 60 
importing from 60-61  

DBMS 8 -9
Default relationship between tables 43 
Default values 49 ,92  
Default Value property 92 
DEL key 54, 102
Delete Column command (Edit menu) 113 
Delete Row command (Edit menu) 54 
Deleting

controls 86 
fields from

queries 112-113  
tables 5 3 -5 4  

join lines 102 
labels 86
query columns 112-113  
rows 5 3 -5 4  
text boxes 86 

Descending order, sorting records in 111 
Descriptions, field 

adding 46
status bar display 90-91  

Design button. Database window 25. 30, 31, 74

Design view 
forms

command buttons 151 
described 74 -7 5  
resizing controls 76-77  
selecting controls 76-77  
toolbar 33 
toolbox 82-83  

modifying objects 31 
queries 106-109, 114-115  
reports 142, 144-145  
tables

creating 4 2 -4 3  
deleting fields 53-55  
inserting fields 53-55  
rearranging fields 54-55  

Design View button, Toolbar 54, 106, 108 
Designing tables on paper 40-41  
Detail section

See also Sections 
forms 75, 79 
reports 144-145  

Documentation 34-35  
Dollars See Currency 
Dragging 

columns
datasheet 57 
queries 114 

controls 7 6 -8 0  
dialog boxes 121 
fields to

filters 127 
join tables 103,132  
QBE grid 104-105, 132 

Query window objects 100 
rearranging fields 55 
resizing rows 5 6-57  
tables to queries 99 
toolbox 82 
widening sections 79 

Drawing join lines 103 
Dynasets

See also Queries
defined 10-11, 106
filtering 124
printing 116-117
specifying criteria 106-107
updating tables from 11,106-107
viewing 26
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E
Edit Filter/Sort button, Toolbar 124 
Editing

See also Modifying 
labels 82-83  
records 52-53  
undoing changes 53, 69 

END key 53
Entering data See Data entry 
Error checking See Validation rules 
ESC key (undo) 53 
Excel See Microsoft Excel format 
Exit command (File menu) 21 
Expand See Resizing; Size
Exporting files See Output To command (File menu) 
Expressions

See also Functions; Totals 
Access Basic modules 15 
calculated controls 92 
field names without spaces 47 
query criteria 109 
validation rules 93 

External tables 60

F
Fl key (Help) 35 
F2 key (select current field) 53 
F6 key (property sheet) 49 
Field names

adding fields to
queries 104-105 
tables 44, 46-47  

label text 83 
spaces in 47 

Field properties
See also  Format property; Properties 
described 31 
setting 48 -49  

Field selector 57 
Fields

See also  Columns; Controls 
adding to 

filters 127
queries 104-105, 132 
tables 44 -47  

data types 44-47 , 49

Fields (continued)
default values 49, 92 
defined 10 
deleting from

queries 112-113  
tables 5 3 -5 4  

descriptions 46, 90-91  
filtering by See Filters 
finding values 120-121 
indexed 101, 121 
inserting in tables 53-55  
moving to 53, 68 
naming See Field names 
primary key 43, 101 
properties 31, 4 8 -4 9  
querying See Queries 
rearranging in tables 53-55  
reports See Reports 
RowSourceType property 90 
selecting 53 
undoing changes 69 
validation rules 93 

File formats
importing data 60 
Output To command 143 

File names 28-29  
Fill color (controls) 85
Filling in values See Data entry; Default values 
Filter window 124-127  
Filters 124-127
Find command (Edit menu) 120, 125 
Find dialog box 120-121 
Finding

See also Filters; Queries 
values 120-121, 125 

First record button 67 
Font (label text) 84 
Font size (label text) 84 
Footers

form footer 75 
group footer 144-145 
page footer 75, 144-145  
report footer 144-145 

Form See Forms
Form button, Database window 25, 27, 30 
Form footer 75 
Form header 75
Form Header/Footer command (Format menu) 75
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Form view
See also Forms 
moving to records 67 
Output To command 143 
printing forms 70 
status bar 90-91  
switching to 67 
viewing data 66 

Form View button, Toolbar 67 
Form Wizards 64 -65 , 131, 133 
Format property

See also Properties 
dates 3 1 ,4 8 -5 0 ,6 8  
numbers 48 
setting 4 8 -49  

Formatting (changing appearance of) text 84 
Forms

See also Form view 
adding records 6 8 -6 9  
closing 70-71  
controls See Controls 
creating

described 3 0 -3 2 ,6 4 -6 5 , 133 
subforms 130-131, 139 

defined 12-13  
Design view See Design view 
detail section 75, 79 
fields See Fields 
filters 124, 127 
footers 75 
headers 75
object button described 25 
opening

command button 150-152  
Database window 27, 120 
Design view 74 
macros 14 

Output To command 143 
Print Preview 70 
printing 70, 89 
properties 88-93  
query-based 64-65 , 131-133  
reports vs. 139,141 
saving 70-71  
sections 75, 79, 8 8 -93  
subforms 82-83 , 130-131, 139 
viewing 2 7 ,6 6 -6 7 , 127 

Formulas See Expressions 
Francs See Currency 
Freestanding labels 8 2 -86 , 88

Functions
See also Expressions 
AccessBasic 15 
aggregate See Totals 
Date() function 92 
In() function 109

G
Go To command (Records menu) 67, 68
Graph tool 82-83
Graphics

See also Controls; Objects 
in reports 139 

Graphs
controls displaying 13 
Graph tool 82-83  
object, defined 15 

Greater than (>) symbol 109 
Group footer 144-145 
Group header 144-145  
Grouping data

See also Sorting records 
reports 139-141, 144-145  
subforms 130-131, 139

H
Hand (pointer shape) 7 8 -8 0  
Handles, control 76, 80 
Headers

form header 75 
group header 144-145 
page header 75, 144-145  
report header 144-145  

Help
Cue Cards 34 
described 35 
searching 35 

Help button, Toolbar 35 
HOME key 53

I

Icons
external tables 60 
Microsoft Access 19-21 
minimized table 58-59  

Import command (File menu) 61
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Importing data 60-61
In() function 109
In() operator 126
Indexed fields 101,121
Insert Column command (Edit menu) 114
Insert Row command (Edit menu) 55
Inserting

fields in tables 53-55  
query columns 114 

Installing See Setup 
Italic 84, 88 
Italic button, Toolbar 84

J
Join Properties command (View menu) 103 
Join Properties dialog box 103 
Joining tables in queries 100-103

K
Key See Primary key 
Keyboard shortcuts

ALT+DOWN ARROW (open list) 49
CTRL+' (insert value of same field, previous record) 53
DEL key 54, 102
END key 53
ESC key (undo) 53
Fl key (Help) 35
F2 key (select current field) 53
F6 key (property sheet) 49
HOME key 53
SHIFT+SPACEBAR (select row) 54
SHIFT+TAB (move to previous field or cell) 53, 68
TAB key (move to next field or cell) 53, 68

L
Label tool 82-83  
Labels

See also  Controls 
adding 82-83  
attached 7 6 ,7 8 -8 1 ,8 8  
changing appearance 84-85  
defined 66, 82 
deleting 86 
editing 82-83  
freestanding 82-86, 88 
Label tool 82-83

Labels (continued)
mailing See Mailing labels 
moving 78-81  
properties 88 
styles 84-85  

Last record button 67 
Layout

See also Design View; Print Preview 
datasheet, saving 57 
forms See Forms 
reports defined 12-13  

Learning Microsoft Access 34 
Left-aligned See Alignment (label text)
Line tool 82-83  
List Box tool 82-83 , 86-87  
Listboxes 8 2 -8 3 ,8 6 -9 1  
Lock tool 82-83

M
Macro button, Database window 25 
Macros 1 4 -1 5 ,2 0 ,2 5 , 153 
Magnifying glass pointer (zoom) 70, 142 
Mailing labels 146-147  
Mailing Labels Report Wizard 146-147 
Max 113
Medium Date format 31, 48-50, 68 
Menu bar 24 
Microsoft Access

Basic See Access Basic 
Cue Cards 34 
databases See Databases 
defined 1-2  
documentation 34-35  
Help 34-35  
icon 19-21
importing data to 60-61  
learning 34 
quitting 20-21  
requirements 18-19  
setup 18-19,61  
starting 20-21  
status bar See Status bar 
toolbar See Toolbar 
version 1.0 files, using 23 
window 24 
Wizards See Wizards 

Microsoft Access Building Applications 34 
Microsoft Access Getting Started, described 2 -3 , 34 
Microsoft Access User's Guide 34
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Microsoft Excel format 143 
Min 113
Minimizing tables 58 
Modifying

See also Editing 
objects 30-31  
queries 114-115 

Module button, Database window 25 
Modules 14 -15 ,25 , 153 
Money See Currency 
Mouse pointer See Pointer 
Move handles 76, 80 
Moving 

columns
datasheet 5 6 -57  
query 114 

controls 78-81  
labels 78-81  

Moving to
fields or cells 53, 68 
records 67 

Multiple criteria 108-109

N
Naming

fields See Field names 
files 28-29  
objects 31, 44 
tables 43 

Navigation buttons 
Form view 67
Page buttons (Print Preview) 143 

Network setup 19 
New See Adding; Creating 
New button. Database window 25, 30 
New command (File menu) 30, 65 
New Database button, Toolbar 28 
New Database command (File menu) 28 
New Database dialog box 28 
New Form dialog box 32, 65, 131, 133 
New Query dialog box 99, 132 
New Report dialog box 140 
New Table dialog box 42 
NEWCUST.DBF 61 
Next record button 67 
Northwind Traders Database 21-23 , 28 
Number sign (#) wildcard 120

Numbers
data type 44 -4 5 , 47 
Format property 48 
record numbering See Counter 

NWIND.MDB 2 1 -2 3 ,2 8

0
Object buttons. Database window 25, 30 
Objects

See also specific objects 
bound object frame tool 82-83  
creating 30 -32  
defined 15 
macros combining 15 
modifying 30-31  
naming 31, 44 
object buttons 25, 30 
properties See Properties 
selecting 15
unbound object frame tool 82-83  

OEM Text format (.TXT) 143 
One-to-many relationship See Subforms 
Online Help See Help 
Open button, Database window 25, 30 
Open Database command (File menu) 22 
Open Database dialog box 22 
Opening

See also Creating 
databases

command line 20-21  
described 22-23  

forms
command button 150-152  
Database window 27, 120 
Design view 74 
macros 14 

reports
Design view 144 
Print Preview 141 

toolbox 82 
Option button tool 82-83  
Option group tool 82-83  
OR, combining criteria with 108 
Output To command (File menu) 143
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P
Page break tool 82-83  
Page buttons (Print Preview) 143 
Page footer 

forms 75 
reports 144-145  

Page header 
forms 75 
reports 144-145  

Page Header/Footer command (Format menu) 75, 145 
Palette button, Toolbar 84-85  
Palette 84-85  
Paradox 60
Pass-through queries 117
Pencil symbol (record indicator) 52
Photos See Graphics
Pictures See Graphics
Pointer

See also Dragging 
field symbol 103 
hand 78 -8 0  
magnifying glass 70, 142 
Pointer tool 82-83  
reordering columns 57 
resizing rows 56-57  
widening sections 79 

Pointer tool 82-83  
Pounds See Currency 
Previous record button 67 
Primary key 43, 101 
Print button, Toolbar 

forms 70 
mailing labels 147 
reports 143 
tables 58 

Print command (File menu) 
forms 70 
mailing labels 147 
queries 116 
reports 143 
tables 58 

Print dialog box 
forms 70 
mailing labels 147 
queries 116 
tables 58 

Print Preview 
forms 70 
mailing labels 147 
reports 140-143

Print Preview button. Toolbar 70 
Printing

dynasets 116-117 
forms 70, 89 
mailing labels 146-147 
reports

described 13, 138, 142-143 
macros 14, 150 

tables 58
Programming See Access Basic; Command buttons; Macros 
Properties

controls 85, 88-93  
defined 31 
fields 3 1 ,4 8 -4 9  
form sections 88-93  
Format See Format property 
forms 88-93  
join lines 103 
labels 88
setting 4 8 -4 9 , 88-93  

Properties button, Toolbar 88 
Properties command (View menu) 88

Q
QBE grid

See also Queries 
adding fields 104-105,132  
described 100 
Total row 112-113  

Queries
action 117
adding fields 104-105, 132 
adding tables 99-100, 132 
column width 114-115 
creating 3 0 -3 2 ,9 8 -9 9 , 132-133 
criteria 106-109  
crosstab 117 
data-defmition 117 
defined 10-11, 100 
deleting fields 112-113 
Design view 106-109 ,114-115  
dynasets See Dynasets 
excluding fields from datasheet 115 
filters vs. 127
forms based on 64-65, 131-133 
grid See QBE grid 
inserting columns 114 
joining tables 100-103 
modifying 114-115
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Queries (continued) 
moving columns 114 
object button described 25 
Output To command 143 
pass-through 117 
Query window described 100-101 
reports based on 133,139-141  
RowSourceType property 90 
saving 116-117  
select 98-99  
sorting 110-111 
subforms vs. 130-131  
totals 107, 112-113  
union 117 
viewing

Datasheet view 26, 105, 109 
queries vs. tables 127 

Query button, Database window 25, 26, 30, 98 
Query Design command (View menu) 106, 108 
Query window

adding tables 99-101 , 132 
described 100-101  
joining tables 100-103  
modifying queries 114-115  

Query-by-example See QBE grid 
Question mark (?) wildcard 120 
QuickForm button, Toolbar 65 
Quitting Microsoft Access 20-21  
Quotation marks (") 

filter criteria 126 
query criteria 107

R
Raised appearance 84 -8 5  
RDBMS defined 8 -9  
Record indicator 52 
Record selectors 52 
Records 

adding in
forms 68-69  
tables 50-53  

current 52 
defined 10
dynasets See Dynasets 
editing 52-53  
filtering 124-127  
grouping See Grouping data 
moving to 67 
numbering See Counter

Records (continued) 
querying See Queries 
record indicator 52 
record selectors 52 
reports See Reports 
saving 50-51 , 68 
showing all 124 
sorting

datasheet 122-123 
filtering and 126-127 
queries 110-111 

subforms 130-131 
viewing

datasheet 26-27, 50, 6 6 -6 7  
forms 2 7 ,6 6 -6 7 , 127 
query results 105,127 
tables 26, 66, 127 

Rectangle tool 82-83
Reformatting See Format property; Formatting (changing 

appearance of) text 
Relational database management system (RDBMS) 8 -9  
Relationships between tables 

creating tables 43 
joining tables in queries 100-103  
relational database defined 9 

Report button, Database window 25, 30, 140 
Report footer 144-145
Report Header/Footer command (Format menu) 145
Report header 144-145
Report title See Report header
Report Wizards 140-142
Reports

controls 144
creating 30-32, 140-141  
Datasheet view vs. 139 
defined 13 
described 138-139  
Design view 142,144-145  
footers 144-145 
forms vs. 139,141 
grouping data 1 3 9 -1 4 1 ,144-145  
headers 144-145  
mailing labels 146-147  
object button described 25 
opening

Design view 144 
Print Preview 141 

Output To command 143 
Print Preview 140-143
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Reports (continued) 
printing

described 13, 138, 142-143  
macros 14, 150 

query-based 133, 139-141 
saving 142-143  
sections 144-145  
totals 138, 141 

Requirements, Microsoft Access 18-19  
Resizing

See also Size
columns See Column width 
controls 76-77  
rows 56-57  

Restoring tables 58-59  
Rich Text Format (.RTF) 143 
Right-aligned See Alignment (label text) 
Row selector 54-55  
Rows

datasheet/table
See also Records 
defined 10 
Design view 54-55  
resizing 56-57  
viewing 26 

QBE grid
adding fields 104-105,132  
Total row 112-113  

query criteria 108 
RowSource property 90 
RowSourceType property 90 
RTF file extension 143 
Rulers 81 
Running

macros 15,20,153  
Microsoft Access

See also Starting Microsoft Access 
requirements 18-19  
Setup program 18-19,61  

module functions 15

S
Save As dialog box 

forms 71 
queries 116 
reports 143 

Save command (File menu) 
queries 116 
reports 143 
tables 49

Save Form As command (File menu) 71 
Save Record command (File menu) 68 
Save Table command (File menu) 57 
Saving

datasheet layout 57 
forms 70-71  
Output To command 143 
queries 116-117  
records 50-51 , 68 
reports 142-143  
tables 49, 57, 59 

Scrolling
Datasheet view 26, 67 
reports in Print Preview 142-143 
subforms 131 

Search command (Help menu) 35 
Search dialog box 35 
Searching

for data See Filters; Finding; Queries 
in Help 35 

Sections
forms 75, 79, 88-93  
properties 88-93  
reports 144-145 

Select Form command (Edit menu) 88 
Select queries 9 8 -99  
Selecting

controls 76-77  
current field 53 
objects 15
query fields 104-105  
rows 54-55  

Setting
default values 49, 92 
properties 48-49 . 88-93  

Setup
dBASE drivers 61 
Microsoft Access 18-19, 61 

SETUP.EXE 18
SHIFT+SPACEBAR (select row) 54
SHIFT+TAB (move to previous field or cell) 53, 68
Shortcut keys See Keyboard shortcuts
Show All Records button. Toolbar 124
Show All Records command (Records menu) 124
Show box (QBE grid) 115
Size

columns See Column width 
controls 76-77  
label text 84 
object property 31 
rows 56-57
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Size command (Format menu) 84 
Size handles 76 
Sort Up button, Toolbar 123 
Sorting records

See also Grouping data 
datasheet 122-123  
filtering and 126-127  
queries 110-111 

Sorting and Grouping command (View menu) 145 
Spaces in field names 47 
Spacing in mailing labels See Mailing labels 
Specifying criteria See Criteria 
Spreadsheets, using reports in 143 
SQL

data-definition queries 117 
external tables 60 
network setup 19 
pass-through queries 117 

Starting Microsoft Access 20-21  
Status bar

field descriptions 90-91  
Help 35 

StatusBarText property 90 
StDev 113
Structured Query Language See SQL 
Styles

See also Properties 
label text 84-85  

Subform tool 82-83  
Subforms 82-83 , 130-131, 139 
Subtotals 141 
Sum 113
Summary functions See Totals 
Sunken appearance 85
System (Microsoft Access) requirements 18-19

T
TAB key (move to next field or cell) 53, 68 
Table button, Database window 25-26 , 30, 42 
Table Wizard 42 -4 4  
Tables

See also Datasheet view 
adding fields 4 4 -47  
adding records 5 0 -5 3  
closing 52-53 , 5 8 -5 9  
creating 30-32, 4 2 -4 5  
defined 10-11 
designing on paper 40-41  
external, attaching 60

Tables (continued) 
filtering 124-127  
forms based on See Forms 
icon 58-59  
importing 60-61  
joining 100-103 
list box source 87, 90 
minimizing 58 
naming 43
object button described 25 
Output To command 143 
primary key 43, 101 
printing 58 
querying See Queries 
rearranging 53-55  
relational database defined 9 
relationships between 

creating tables 43 
joining tables in queries 100-103  
relational database defined 9 

restoring 58 -5 9  
RowSourceType property 90 
saving 49, 57, 59
updating from dynaset 11, 106-107  
viewing 26, 66, 127 

Tallies See Totals 
Testing command buttons 152 
Text

boxes See Text boxes 
data type 4 4 -45 , 47 
file format 143 
label text 66, 82-85  

Text Box tool 82-83  
Text boxes

See also Controls 
bound control 86 
calculated controls 92 
deleting 86 
described 66 
forms 80 
list box vs. 86 
moving 78-81  
resizing 77 
selecting 76 
Text Box tool 82-83  

Three-dimensional appearance 84-85, 88 
Time (Date/Time data type) 44 
Toggle button tool 82-83
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Toolbar
Apply Filter/Sort button 126 
arranging 33 
Bold button 84 
Close button 143 
Cue Cards button 34 
Datasheet View button 

query results 105,109 
sorting records 122
switching to Datasheet view 27, 50, 54, 67 

described 24, 33 
Design View button 54, 106, 108 
Edit Filter/Sort button 124 
Form View button 67 
Help button 35 
Italic button 84 
New Database button 28 
Palette button 84-85  
Print button 

forms 70 
mailing labels 147 
reports 143 
tables 58 

Print Preview button 70 
Properties button 88 
QuickForm button 65 
Show All Records button 124 
Sort Up button 123 
Totals button 112 
Undo button 69 
Zoom button 70 

Toolbox
adding controls 86-87  
closing 82
Command Button tool 82-83, 151 
Control Wizards button 82-83, 86, 151 
described 82-83  
opening 82 

Toolbox command (View menu) 82 
Totals

queries 107,112-113  
reports 138, 141 

Totals button, Toolbar 112 
Totals command (View menu) 112 
Triangle (record indicator) 52 
True/false See Yes/No data type 
TXT file extension 143

U
Unbound controls 92
Unbound object frame tool 82-83
Undo button, Toolbar 69
Undo Current Field command (Edit menu) 69
Undo Typing command (Edit menu) 69
Undoing changes 53, 69
Union queries 117
Updating

action queries, using 117 
tables from dynaset 11, 106-107

V
Validation rules 93 
ValidationRule property 93 
ValidationText property 93 
Values

See also Data 
default 49, 92
expressions See Expressions 
finding 120-121, 125 
list of See List boxes 

Var 113 
Viewing data

Datasheet view 26-27 , 50, 66-67  
described 26-27 , 127 
forms 2 7 ,6 6 -6 7 , 127 
queries

Datasheet view 26, 105, 109 
vs. tables 127 

tables 26,66, 127 
Views See Datasheet view; Design view; Form view

W
Widening

See also Resizing; Size 
columns See Column width 
sections 79 

Wildcard characters 
finding values 120 
query criteria 109
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Windows
See also Datasheet view; Design view; Form view
Database window See Database window
Filter window 124-127
Microsoft Access window 24
Print Preview See Print Preview
Query window See Query window

Wizards
Autoform Wizard 64-65
Command Button Wizard 15,150-153
Control Wizards button, Toolbox 82-83, 86, 151
creating objects 31, 32
Form Wizards 6 4 -6 5 , 131, 133
Mailing Labels Report Wizard 146-147
Report Wizards 140-142
Table Wizard 4 2 -4 4

Word processors, using reports in 143

X
XLS file extension 143

Y
Yen See Currency
Yes/No data type 45, 47

Z
Zoom (Print Preview) 

forms 70 
reports 142

Zoom button. Toolbar 70


